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Architecture 

Introduction 
Welcome to the Smar ProcessView™ family of Web-enabled industrial automation software for 
Microsoft® Windows® operating systems, featuring OPC™-based client and server applications for 
Human Machine Interface (HMI), SCADA and Control. 
This Getting Started manual will help you get up and running with your new software quickly and 
easily.  It will show you how to: 

• Install the ProcessView software. 
• Authorize a ProcessView software license. 
• Navigate the GEN32 Demo. 
• Work with the online GraphWorx tutorial. 
• Configure an OPC tag. 
• Create a simple project with graphics, trends, and alarms. 

There is also a section on tips and tricks for working efficiently on projects, and a quick explanation 
of the other tools offered by ProcessView. 
The remainder of this chapter provides some background on the following information: 

• What is OLE™ for Process Control? 

• What is ProcessViewEnterprise Edition™? 

• System components: clients and servers 

• Creating your custom project  

What Is OLE for Process Control? 
OLE™ for Process Control (OPC™) is a standards-based approach for connecting data sources 
(e.g., PLCs, controllers, I/O devices, databases, etc.) with HMI client applications (graphics, 
trending, alarming, etc.). It enhances the interface between client and server applications by 
providing a universally supported and well-documented mechanism to communicate data from a 
data source to any client application. Included is not only a detailed guide on how to pass the data, 
but also specific information on other attributes to supplement those data, such as range 
information, data type, quality flags, and date and time information. To understand better the 
difference between the old/traditional client-server architecture and the OPC based client-server 
architecture, consider the illustrations shown in Figure 1.1 and Figure 1.2. 

 
Figure 1.1. Old/Traditional Client-Server Architecture 
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In the old/traditional case, as shown in Figure 1.1, each client is required to write its own set of 
servers to the devices (each line above represents a software interface driver). This is due to the 
fact that although the protocol of a device or a server may not change, the architectures of the 
different client applications (from different vendors) are different. This leads to increased load on the 
machine, work in setting it up, costs for doing the project, and time needed to implement the 
solution. If the device or server’s protocol is changed or updated, then each of the client applications 
must also change.  

 
Figure 1.2. OPC-Based Client-Server Architecture 

Figure 1.2 shows the OPC Architecture, which was introduced by the OPC Foundation mainly to 
overcome this issue. By following the OPC Architecture, a device needs only one standard driver, 
which is an OPC-compliant server. All OPC-compliant client applications can then be connected to 
that device, either locally or over a network. Furthermore, connections can be made to more than 
one OPC server at the same time. 
Any OPC client application can connect to any OPC server. In other words, OPC offers true Plug-
and-Play capability in the fields of HMI and industrial automation. OPC server types include OPC 
Data Access (DA), OPC Alarm and Events (AE), and OPC Historical Data Access (HDA). 

What Is ProcessView Enterprise Edition? 
Smar offers the following stand-alone OPC client applications for graphics, data collection/trending, 
and alarming: 
• GraphWorX™ 
• TrendWorX™ 
• AlarmWorX™ 
Each client application is an ActiveX™ container featuring Internet/intranet-ready object technology 
and offering Microsoft‘s powerful Visual Basic® for Applications (VBA) technology. 
ProcessView Enterprise Edition™ is a suite of these software components that provides a complete 
solution for HMI/SCADA software applications.  In addition to the above three main modules, the 
following applications are also included: 
• ScriptWorX™ 
• ProjectWorX™ 
• Screen Manager 
• DataSpy™ 
• GenBroker™ 
• Dr. DCOM 
• Security Server 
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Smar also offers a variety of other software modules to complement the ProcessView Enterprise 
Edition.  The following are available as add-on options: 
• WebHMI™ 
• DataWorx™  
• AlarmWorx Multimedia™  
• ControlWorX™ 
• MobileHMI™ 
• ReportWorX™ 
• Symbol Library 
• ActiveX ToolBox™ 
• SMAR OPC Servers 
• Third-party OPC Servers 
• OPC ToolWorX™ 
• ActiveX ToolWorX™ 

 
Figure 1.3 illustrates how each of these components fits in to the OPC automation architecture. A 
brief explanation of each of the software modules follows. 
Note: For more information about these products, please visit the Smar Web site at www.smar.com. 

 
Figure 1.3. OPC Automation Tool Suite™ 

GraphWorx 
GraphWorx is a stand-alone OPC client software package for Human Machine Interface, providing a 
rich set of tools for creating animated graphics.  This is where the visualization of the process is 
created for the operator interface. GraphWorx combines drawing, operating procedures, quality 
reporting, and management directly into your operator displays using your choice of ActiveX 
Controls and Visual Basic for Applications (VBA) scripting language. 
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Key features: 
• True 32-bit, multi-threading, multi-platform design. 
• Universal OPC connectivity to OPC Data servers. 
• Visual Basic for Applications (VBA). 
• Object-based graphics. 
• Powerful display creation and animation tools. 
• Scalable and fixed scale displays. 
• Embedding of ActiveX Controls and OLE objects. 
• Dynamic animation updates up to 50 ms. 
• Web-friendly: can be embedded into Visual Basic and HTML pages. 
• ActiveX document server: Can be viewed using Web browsers such as Microsoft Internet 

Explorer and Netscape Navigator. 
• Advanced Symbol Library. 
• TrendWorx and AlarmWorx objects can be embedded within it, providing a comprehensive 

operator interface. 
• Built-in expressions and calculations. 
• Local and global aliasing. 
• CAD-style layering. 
• Time-saving graphics templates. 
• Language switching. 
For additional information about GraphWorx, please see the Help documentation for this application. 

TrendWorx 
TrendWorx is a stand-alone OPC client software package for collecting real-time data, logging data 
to a database, trending both real-time and historical data, while providing a powerful set of reporting 
and analysis tools. TrendWorx offers an open solution to applications requiring scalable and 
distributed real-time performance using the latest OPC HDA specification for creating Plug and Play 
historical data servers and clients. 
Key features: 
• True 32-bit, multi-threading, multi-platform design. 
• Universal OPC connectivity to OPC Data servers. 
• Serves up logged data using OPC Historical Data Access. 
• Visual Basic for Applications (VBA). 
• OPC Trending ActiveX, with the flexibility of supporting time-based trends, XY Plots, logarithmic 

trends, bar graphs, strip charts, and circular chart trend displays. 
• Runtime editing of trend windows. 
• Multiple zoom levels for detailed analysis. 
• Trend and log expressions and calculations. 
• Statistical information on trended data. 
• Ideal batch trends. 
• Mix real-time and historical data in the same trend. 
• Logger can run as an NT Service. 
• Logs data using ADO / OLEDB technology. 
• Supports Microsoft Access, Microsoft SQL Server, Oracle and MSDE databases. 
• Log batch information. 
• Filter and compress data using a variety of functions. 
• Attach operator comments to logged data. 
• Schedule historical reports.  
• Trigger reports based on data conditions. 
• Publish reports to the Web. 
• Language switching. 
For additional information about TrendWorx, please see the Help documentation for this application. 
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AlarmWorx 
AlarmWorx is a stand-alone OPC client software package for distributed enterprise-wide alarm and 
events.  It is a complete alarm management system. You can network enterprise-wide alarm 
management for detecting, sorting, filtering, viewing, reporting, and acknowledging OPC server 
alarms and events. 
Key features: 
• True 32-bit, multi-threading, multi-platform design. 
• Universal OPC connectivity to OPC Data servers. 
• Serves up alarms using OPC alarms and events. 
• Visual Basic for Applications (VBA). 
• Network-based client/server architecture. 
• Alarm Server can run as an NT Service. 
• Configures limit, rate of change, deviation, and digital alarms. 
• Alarm on expressions and calculations. 
• Tracks and logs operator actions. 
• Supports auto-archiving of alarm records. 
• Redundant backup printer support. 
• Alarm ActiveX Control for viewing/acknowledging active alarms: Can be embedded into Visual 

Basic and HTML Internet/intranet-based Web pages. 
• Configures colors, fonts, and styles used for alarm display. 
• Historical Alarm Analysis ActiveX Control: pareto charts, reports, histograms, etc. 
• Alarm troubleshooting system: On-screen alarm- and operator-help information. 
• Publishes alarms to the Web. 
• Language switching. 
• FDA 21 CFR Part 11 compliance. 
For additional information about the AlarmWorx, please see the Help documentation for this 
application. 

ScriptWorx 
ScriptWorx is a powerful stand-alone application that allows the creation and management of Visual 
Basic for Applications (VBA) scripts.  ScriptWorx’s unique multi-tasking, multi-processor 
environment allows multiple scripts to run concurrently.  User-defined VBA scripts can perform OPC 
read-and-write operations to any OPC server, which interfaces to factory floor devices such as PLCs 
and other OPC-compliant servers.  ScriptWorx simultaneously performs calculations, manages 
databases, and executes any operation available in the VBA language to access reports or perform 
recipe operations 
As part of the ProcessView Enterprise Edition, it offers project-level scripting. 
Key features: 
• True 32-bit, multi-threading, multi-platform design. 
• Runs on Microsoft Windows 95, Windows 98, Windows, Millennium, Windows NT, Windows 
2000, and Windows XP.  
• Powerful VBA scripting container.  
• Comes with Visual Basic for Applications.  
• Executes VBA scripts simultaneously. 
• Automatically creates VBA scripts using the Script Wizard.  
• Executes scripts based on time schedules.  
• Executes scripts based on OPC Data events.  
• Executes scripts based on OPC alarms.  
• Easy-to-use configuration.  
• Script monitor provides analysis capability.  
• Compiles VBA scripts for multiple uses.  
• Interface to Corporate MES/ERP systems.  
• Integrates Microsoft Access, Microsoft SQL Server, Oracle and MSDE databases. 
• Provides global scripting to other applications. 
• Full OLE automation interface provided.  
• Integrates with third-party applications. 
For additional information about the ScriptWorx, please see the Help documentation for this 
application. 
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ProjectWorx 
ProcessView contains numerous applications with multiple components, requiring a well-trained user 
in order to successfully create, integrate, deploy, and manage projects. Each of these components 
requires complex setup of many different types of configuration files, databases, and OPC servers, 
as well as runtime and security settings. To simplify the management and deployment of the broad 
spectrum of ProcessView applications, Smar has introduced ProjectWorx, a sort of "super 
configurator" that integrates all ProcessView applications into a single, easy-to-manage format. The 
ProjectWorx user interface is basically a container embedded in the Microsoft Management Console 
(MMC). The ProjectWorx console conveniently consolidates all of your ProcessViewfiles in one 
easily accessible location, enabling you to: 
• Organize all ProcessView application files into separate projects. 
• Create new ProcessView application files and OPC server configurations. 
• Import application files into projects. 
• Start and stop ProcessView applications. 
• Pack project files into a single, compressed file, and unpack project files for easy deployment to 

multiple computers.  
• Activate entire projects into runtime mode. 
• Control the layout of windows using the Screen Manager. 
• Configure security settings to password-protect projects. 
• Back up project files to Microsoft Visual SourceSafe. 
• Search for and replace machine names and OPC tags throughout all project files using a global 

find/replace utility. 
• Publish projects to the Web. 
• Control and monitor runtime functions for all applications using ProcView Tray. 
• Launch ProcessView system tools. 
• Generate comprehensive reports for all files and projects. 
• Import and manage third-party applications. (Note: For information about the adding third-party 

applications to ProjectWorx, please contact info@smar.com.) 
For additional information about ProjectWorx, please see the Help documentation for this 
application. 

Screen Manager 
The Screen Manager is a utility for managing the layout of the displays used for the operator 
interface. The Screen Manager supports configuration not only for a single computer monitor, but 
also for a multiple-monitor system, allowing definitions of various layouts to fill the screen(s).  The 
Screen Manger not only supports the ProcessView application documents, but third-party 
documents as well (e.g., placement of a CAD drawing or a Microsoft Word document).  For 
additional information about the Screen Manager, please see the Help documentation for this 
application. 

DataSpy 
OPC DataSpy is a utility for connecting to OPC servers, serving as a test application and also as a 
convenient tool for viewing OPC information. It can test OPC 1.0 and 2.0 Data Access-compliance, 
as well as OPC 1.0 Alarm and Events compliance.  The analysis tools provided aid in quickly 
trouble-shooting third-party drivers. For additional information about OPC DataSpy, please see the 
Help documentation for this application. 

GenBroker 
DCOM is the method of communication for ProcessView. There are, however, certain disadvantages 
to using DCOM. To overcome DCOM timeout problems, for example, it was necessary to eliminate 
Windows callbacks and reduce the number of different function calls over Windows DCOM 
communications.  
DCOM's major disadvantages are: 
• Its complex settings often make its configuration ineffective when the client is remote. 
• It does not work well across NT domains.  
• Its connection over slow and unreliable networks (e.g., the Internet) is practically impossible.  
• It is not easy to configure to pass through firewalls. 
In response to these difficulties, Smar has enhanced ProcessView with GenBroker, a proven, high-
speed communications utility. Employing a network of applications, GenBroker uses TCP/IP and 
SOAP/XML channels to achieve real-time and secure communications between Web browser clients 
and WebHMI servers. Everything except the method of communication remains the same as before. 
For additional information about GenBroker, please see the Help documentation for this application. 
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Dr. DCOM 
Dr. DCOM is a utility for helping set up DCOM connections for networked OPC clients and servers.  
It tests OPC interfaces on both local machines and those on the network.  An Auto Configuration 
Wizard is provided to assist in the rapid setup of a network solution.  For additional information about 
Dr. DCOM, please see the Help documentation for this application. 

Security Server 
The Security Server is a utility for managing access rights to users and groups of users within the 
ProcessView suite of applications.  A configuration tool permits creating custom groups and 
assigning individuals to those groups (users can be assigned to more than one group). Various 
product features can then be restricted, based on who is logged into the computer during Runtime.   
Configures such items as: 
• Basic, advanced, and NT-integrated security modes. 
• File access restrictions. 
• OPC point/tag write permissions. 
• Time logon permitted. 
• Login station control. 
• User-defined security 
• Password and user/group account management (maximum age, length, etc). 
• Account lockout.  
• Auto logout after timeout for high-level users. 
• Access to development mode. 
• Task switching. 
• Windows access. 
• Online configuration. 
• Several individual features and functions offered by the various client applications within 
ProcessView. For example, it restricts who has access to printing, reports, zooming, menu 
commands, screen switching, trend view manipulations, alarm acknowledgment, and much more. 
For additional information about the Security Server, please see the Help documentation for this 
application. 

WebHMI 
WebHMI provides OPC and visualization information from any Smar ProcessView OPC-based 
product to any computer running Microsoft Internet Explorer or Netscape® Navigator Web browsers. 
Based completely on Microsoft DNA architecture, WebHMI uses ActiveX and DCOM technology to 
provide Web-based visualization. Integrate your HMI application with traditional Web browsers to 
perform remote and low-cost monitoring of key manufacturing information.  WebHMI not only allows 
the viewing of display information but also provides for security, data entry, and real-time interaction 
with your application.  WebHMI allows you to view over the Internet or intranet traditional operator 
real-time displays with animation, live data trends, reports and alarms. 
Key features: 
• Runs on Microsoft Windows 95, Windows 98, Windows, Millennium, Windows NT, Windows 

2000, and Windows XP. 
• Lightweight Web client. 
• Zero-install Web capability.  
• Delivers ActiveX Controls and HTML pages.  
• Requires Microsoft Internet Explorer 5.5 or higher.  
• Serves OPC real-time data over the Web. 
• Uploads graphics, trends, alarms, etc.  
• Provides NT level security.  
• Ideal for viewing remote HTML controllers. 
For additional information about WebHMI, please see the Help documentation for this application. 

GEN-OPC Server 
GEN-OPC Server provides an OPC interface for Smar ProcessView™ Control Series (ProcessView 
for DOS) and ProcessView™ for Windows (GFW). With it, users can connect to existing 
ProcessView and GFW systems from a ProcessView system. Tag names used by these older Smar 
systems appear in the OPC Universal Tag Browser for simple, point-and-click connectivity. This 
protects your investments in existing systems and aids in upgrading them to a ProcessView system. 
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DataWorx 
DataWorx provides patent-pending enabling technology, which includes OPC server-to-OPC server 
data bridging, OPC aggregation and mission-critical OPC-based redundancy. Unique data-bridging 
technology allows the connectivity of any OPC server to any other OPC server, providing Plug and 
Play interoperability. For example, connect an Allen Bradley OPC server to a Siemens OPC server 
and share data easily and seamlessly. Data can also be manipulated through expressions and 
calculations.   
Key features: 
• Both a simultaneous OPC client and server.  
• Runs on Microsoft Windows 95, Windows 98, Windows, Millennium, Windows NT, Windows 

2000, and Windows XP.  
• True 32-bit, multi-threading, multi-platform design.  
• Multilevel OPC data redundancy.  
• OPC server-to-OPC server data bridge.  
• OPC data aggregation. 
• Statistics and performance analyzer.  
• Built-in expressions and calculations.  
• Supports OPC browser interface.  
• Runs as an NT Service.  
• Integrated real-time Data Monitor.  
• Online configuration of OPC tags.  
• NT level security.  
• Supports COM /DCOM and OLE automation.  
• CSV import/export for bulk edit.  
For additional information about DataWorx, please see the Help documentation for this application. 

AlarmWorx Multimedia  
The AlarmWorx Multimedia is an option to AlarmWorx, providing OPC-compliant multimedia 
technology for remote alarm notification.  Various multimedia "agents" are offered, including: 
• Paging (including SMS/TAP support) 
• Two-way paging 
• Phone with call-in and call-out support 
• E-mail  
• Fax 
• Voice annunciation of alarms via text-to-speech 
• Voice annunciation of alarms via recorded .wav files 
• Video 
• Pop-up windows 
• Computer screen marquee 
• Instant messaging 
For additional information about AlarmWorx Multimedia, please see the Help documentation for this 
application. 

ControlWorX 
ControlWorX is a control application to perform plant control.   Its configurator is fully compliant with 
all IEC 6-1131 standard languages and conforms to industry standards. It is also a fully-compliant 
OPC server. You can create, test, and debug IEC 6-1131 PLC Soft Logic and Process applications 
with ease. 
Key features: 
• IEC 6-1131-compliant and supports SFC (Sequential Function Chart), FBD (Function Block 

Diagram), LD (Ladder Diagram), IL (Instruction List) and ST (Structured Text). 
• OPC connectivity and drivers for Interbus-S, CAN, Profibus, Devicenet, Fieldbus, and much 

more. 
• Multiple documentation facilities. 
• Fast and multitasking runtime (as fast as sub-milliseconds). 
• Mix IEC 31 graphical languages. 
• Windows “Object & Alarm” Editing: Object-based editing of POUs, SFC steps, and IL instruction. 
• Powerful built-in runtime debugger to test control logic. 
• Online configuration: No need to interrupt control to implement new or change existing logic. 
• Create reusable control objects. 
For additional information about ControlWorX, please see the Help documentation for this 
application. 
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MobileHMI 
MobileHMITM, Smar Web-enabled mobile telephony software product, connects users to real-time 
manufacturing and production data over their wireless PDAs, PalmTM, Pocket PCs, Web-enabled 
mobile phones, and other handheld devices. MobileHMI, which is the first Smar product to 
incorporate the Microsoft® .NET framework and Mobile Internet Toolkit, uses Wireless Application 
Protocol (WAP) technology, the leading global standard for applications over wireless networks. 
WAP provides a uniform technology platform with consistent formats for delivering Internet and 
intranet-based information and services to digital mobile phones and other wireless devices. 
MobileHMI supports any devices using WAP, WML, cHTML and HTML technologies. For additional 
information about MobileHMI, please see the Help documentation for this application. 

ReportWorX.NET 
Designed from the ground up using Microsoft .NET and Microsoft Excel technology and written in 
the Microsoft C# (C-Sharp), VB.NET and ADO.NET languages, ReportWorX.NET quickly and 
efficiently turns vast amounts of data from any data source into detailed reports. Smar brings you the 
most advanced reporting tool available today, taking maximum advantage of Microsoft’s most 
powerful technologies. ReportWorX.NET uses Microsoft .NET technology to export data into your 
report worksheets and forms and control the execution of these Excel forms without the need for 
Excel to be visible or executing. Workbook duplication, manipulation, chart and data updates, 
formula recalculation and automatic print out and scheduling are completely performed by 
ReportWorX.NET. For additional information about ReportWorX.NET, please see the Help 
documentation for this application. 

Symbol Library 
GraphWorx supports the use of smart symbols in displays.  Smart symbols contain data-point 
connections.  If you load a smart symbol into your display in animation mode, the symbol begins 
displaying data immediately based on that data-point connection.  GraphWorx uses two different 
modes for the Symbol Library: 
• Standard stand-alone Symbol Library  
• Dockable symbol toolbar 
The Symbol Library is available in GraphWorx as a dockable toolbar or a floating window inside 
display files. It can be freely floating above a GraphWorx application or docked to any side of the 
GraphWorx display. Features of the Symbol Library are fully implemented in the Dockable Symbol 
Toolbar. You can create, rename, and delete both category files and symbols within the dockable 
toolbar, as well as unlock categories with passwords and change the look of the symbol icons in the 
view pane. The category file format of the Dockable Symbol Toolbar is fully compatible with previous 
versions of the Symbol Library, and vice versa. For additional information about the Symbol Library, 
please see the Help documentation for this application. 

ActiveX ToolBox 
The ActiveX ToolBoX provides tools for creating your own custom ActiveX controls and embedding 
them in ActiveX containers like GraphWorx.  You can create applications rapidly and professionally 
with high-performance ActiveX controls that are true OPC clients. 
Key features: 
• Designed for Microsoft Windows 95, Windows 98, Windows NT, and Windows 2000.  
• Industry’s first OPC-enabled ActiveX Controls.  
• Includes Visual Basic and HTML examples.  
• Integrates with Visual Basic or Microsoft Office.  
• Integrates with HTML and Web pages.  
• Augments your SMAR WebHMI solution.  
• Realistic 3-D looking ActiveX Controls.  
• Advanced Slider ActiveX.  
• Periodic ActiveX to trigger Visual Basic scripts.  
• Powerful Data / Event ActiveX  
• Includes: Gauge, Switch, and other controls. 
• Multi-threading, multi-processor design.  
• Integrated OPC Tag Browser.  
• Fast dynamic animation. 
• Full documentation.  
• Flicker-free high performance updates.  
• Multi-resolution and scalable ActiveX controls.  
• National Instruments ActiveX site licensing available. 
• Periodic Scheduler ActiveX: Trigger scripts on time-based intervals. 
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• Data Driven Event ActiveX: Connect scripts to any OPC tag. 
• OPC Alarm ActiveX: Trigger scripts based on OPC Alarms conditions. 
• Timer ActiveX: Simple time-driven ActiveX. 
• Numeric ActiveX: Various ways to show numerical data. 
For additional information about ActiveX ToolBoX, please see the Help documentation for this 
application. 

OPC ToolWorX  
OPC ToolWorX is a tool for creating OPC 1.0 and 2.0 Data Access and OPC Alarm server and client 
applications. It includes OPC configuration GUI, Tag Browser, production-grade Modbus OPC 
server as example, detailed documentation, and explanation of OPC concepts and OPC test client. 
With a large number of devices and servers available in the automation market, it is necessary for 
OEMs, end users and system integrators to write their own OPC-compliant server and client 
applications. OPC ToolWorX implements the advanced programming concepts of the OPC 
Specification. 
The OPC ToolWorX contains two integrated toolkits: 
• OPC Server Toolkit 
• OPC Client Toolkit 
The toolkits contain sample source code, documentation, two example servers, a client test 
application, and a Visual Basic Test Application.  
OPC ToolWorX features include: 
• Offered as two all-new OPC ToolWorX products: 
 Full source version  
 Low-cost no-source code version--LIB only version 
• Free threading model. 
• Microsoft ActiveX and COM programming. 
• OLE Automation DLL. 
• Multi-threading. 
• OPC configuration explorer. 
• OPC Toolkit source code provided. 
• Unique universal-based Tag Browser.  
• Creates OPC in-process servers for Windows CE. 
• Utilize Microsoft Visual C++ only. 
• Supports Windows CE: MIPS, Hitachi S3, S4, Intel, Strong Arm processors.  
• Creates OPC servers as NT Service.  
• Supports Microsoft SQL Server, Microsoft Access, and other database configuration. 
• Wizards that create servers in minutes for OPC Data Access and OPC Alarm and Events. 
• Integrated OPC Data Access and OPC Alarm and Events. 
• New powerful distributed remote ADO / OLEDB Database access. 
• Universal Tag Browser with Alarm and Events and HDA support 
• More powerful Rapid Develop Wizards. 
• Supports packed bits capability.  
• OPC 2.0 custom interface & OLE Automation interface support. 
• Support for latest OPC network browsing. 
• Many new runtime speed optimizations. 
For additional information about OPC ToolWorX, please see the Help documentation for this 
application. 
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ActiveX ToolWorX 
ActiveX ToolWorX is the industry’s first and only OPC-based ActiveX toolkit. Create your own 
custom, high-performance ActiveX controls that are true OPC clients. Connect your OPC ActiveX 
Controls to any OPC server.  Embed real-time, OPC-enabled ActiveX controls into most popular 
ActiveX containers, including: Visual Basic, Web-based HTML pages, Microsoft Word, Microsoft 
Excel, Microsoft PowerPoint and many other third-party ActiveX containers.  Create libraries of 
reusable components based on popular Microsoft ActiveX technology. Using standard OPC Plug-
and-Play, connect them to factory floor devices such as PLCs, industrial devices, and much more.  
Key features: 
• Runs on Microsoft Windows 95, Windows 98, Windows NT, and Windows 2000. 
• Industry’s only OPC-based ActiveX toolkit.  
• Create OPC-enabled HMI ActiveX Controls.  
• Embed in any ActiveX container.  
• Includes powerful GraphWorx container.  
• Create realistic looking ActiveX Controls.  
• Powerful animation capability.  
• Includes ActiveX Gauge source code.  
• Native user interface control.  
• Fast dynamic animation.  
• Multi-threading design.  
• Includes OPC Tag Browser.  
• Scalable ActiveX Controls. 
• Flicker-free dynamic updates. 
• Plugs into Visual C++.  
• Rapidly creates OPC-enabled ActiveX Controls using ActiveX Wizard. 
• New Tag Browser Wizard for rapid code generation of Tag Browser interface.  
• Quickly turns GraphWorx-created symbols into OPC-enabled ActiveX. 
 

System Design 
When designing your system, keep in mind that the various applications can run as a stand-alone or 
as a suite on each PC.  For example, the system in Figure 1.4 shows several ProcessView systems 
mixed with a station dedicated to alarming, another dedicated just to trending, and another that 
shows only graphic screens. ProcessView offers the flexibility to scale and expand, as your system 
needs change. 

 
Figure 1.4. System Design Example 
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Chapter 2 
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Instalattion and Requirements 
Introduction 

This chapter provides information about: 
• System Requirements 
• Installing ProcessView 
• Uninstalling ProcessView 

System Requirements 
To use the ProcessView software, you must have the following minimum system requirements: 
• 8X Speed CD-ROM 
• A minimum of 300 MB disk space available for installing the default ProcessView software. 

(Note: The actual amount of space required may decrease if help and example files are not 
installed. Project requirements for logging data, alarms and screen storage are above this 
minimum.) 

• VGA Video Card; 256 or more colors for best results. 
• Microsoft Internet Explorer 5.5 and above. 
• Microsoft Data Access Components (MDAC) 2.7 
• Microsoft Windows 98 SE, Windows 2000 with Service Pack 3, Windows ME, or Windows XP 

with Service Pack 1, or Windows NT® 4.0 with Service Pack 6a 
Note: Windows 98 SE is supported only by the non-Unicode version of ProcessView. 
Minimum computer CPU and RAM requirements depend on the application and operating system, 
as shown in the following table. 
 

Application Size Processr RAM 
Small 
Windows 98 SE/NT 
Workstation/ME, 2000, XP 

 
233 MHz 
400 MHz 

 
64 MB 
128 MB 

Medium 
Windows 98 SE /NT/ME, 
2000, XP  

 
400 MHz 
650 MHz 

 
128 MB 
256 MB 

Large 
All Operating Systems 

 
1.8 GHz 

 
512 MB - 1GB 

 
The actual amount of RAM and/or processor speed will vary depending upon the I/O counts, 
networking, logging and alarming requirements, as well as other factors.  To determine which type of 
computer best fits your application, set up a test application station. 
Note: The processor and memory requirements of your existing project may be greater in this 
version of ProcessView than in previous versions due to additional and enhanced features in the 
product. 
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Installing ProcessView 
The following steps detail the ProcessView system installation. Before installing Smar software, be 
sure to close all other applications. 
Note: If your operating system (e.g., Windows NT) requires a login name, you must log in with 
administrator capability before installing ProcessView software. 

1. Before installing Smar software be sure that all other applications, are closed and/or disabled. 

2. Insert the ProcessView product CD into your CD-ROM drive.  If "Autorun" is enabled on your 
system, the CD introduction starts automatically.  Otherwise, browse to your CD-ROM drive and 
run the "RunMe.bat" file. 

3. During the ProcessView 7.0 installation, the system will look for a prior installation of the 
ProcessView License Utility. If a previous installation of the License Utility is detected, an update 
is required. If your PC is currently licensed, a temporary ProcessView 7.0 license with the 
current configuration can be immediately granted for a 30-day temporary period. All current 
options and licensing information will be retained for 30 days. Please contact Smar for a license 
upgrade within the temporary 30-day period.  

Note 
ProcessView version 5.x and 6.x software licenses must be upgraded to work with ProcessView 
version 7.0 or subsequent versions of ProcessView 

4. You will see the CD introduction and the main menu. From here you can click on a link to the 
Smar Web site, go to the Documentation Center, view CD-based Web pages containing 
miscellaneous information, and install software.  

5. Click on the ProcessView button. The Setup screen briefly appears, followed by the Welcome 
Message screen, as shown in Figure 2.1. Click the Next button to continue. 

 
Figure 2.1. Welcome Screen 
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6. The Software License Agreement dialog box appears, as shown in Figure 2.2. Read the 
License Agreement. Click Yes if you accept the terms of the agreement. 

 
Figure 2.2. Software License Agreement 

7. The User Information dialog box appears, as shown in Figure 2.3. Enter your name in the 
Name field and your company information in the Company field. Click Next. 

 
Figure 2.3. User Information 
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8. The Security Password dialog box appears, as shown in Figure 2.4. Type SMAR (upper case) 
as the security password. This password will be used by the Security Server as the default 
administration password. Then click the Next button to continue. 

 
Figure 2.4. Default Security Administration Password 

 

IMPORTANT NOTE 
Be sure to remember this password! It is required when you first attempt to log in to the Security 
Configurator tool to set up security for your system.  Details on using the Security Configurator are 
covered later in this manual. The important point here is to make sure you remember what is entered in 
this field during installation 

9. The Choose Destination Location dialog box appears, as shown in Figure 2.5. Select the 
destination location for the software installation. The default directory for the setup is Program 
Files\Smar\ProcessView. If you wish to keep this default location, click the Next button to 
continue. If you prefer to select a different directory location for the installation, click the Browse 
button to select a different drive or directory. Click Next to continue. 

 
Figure 2.5. Choosing the Destination Location 
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10. The Component dialog box appears, as shown in Figure 2.6. By default, the components and 
subcomponents installed by ProcessView require at least 300 MB of disk space. If you lack the 
space, a message appears asking you either to change hard drives or delete unnecessary files 
from your current drive.  

There are subcomponents installed in many of the components. These subcomponents are typically 
broken into three subsections: program files, help files, and example files. If you do not have enough 
disk space to install the complete set of tools, you can elect either not to install one or more of the 
main components (e.g., DataWorx) or some of the subcomponents (e.g., help files).  If you only 
install the program files, for example, the amount of hard disk space required decreases. To make a 
change, highlight the component and click the Change button. This will open the Subcomponents 
dialog box for that component. A check indicates that the component (or subcomponent) will be 
installed. Click Next to continue. 

 
Figure 2.6. Selecting ProcessView Components  

11. The Select Components dialog box appears, as shown in Figure 2.7. Here there are two 
additional options available for a ProcessView installation: 

• Browser Station Installation. This option should be used when installing the software on a 
networked PC that ties into another ProcessView system.  A "Browser Station," which cannot 
connect directly to an OPC server, must connect to a remote machine. For a typical installation, 
this option should NOT be checked.  

• GraphWorx Runtime Only. This option creates an installation whereby GraphWorx (the 
graphics screen-building module in ProcessView) cannot enter Configuration mode. For the 
typical installation, this option should NOT be checked. Click Next to continue. 
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Figure 2.7. Selecting ProcessView Components 

12. The Select Program Folder dialog box appears, as shown in Figure 2.8. You can choose the 
program folder in which the software will be installed. The default folder in the Program Folder 
field is Smar ProcessView. You can keep this default, select an existing folder from the list, or 
type a new folder name in the Program Folders field. Click Next to continue. 

 
Figure 2.8. Selecting the Program Folder 

 
The copying of files will now begin. Click Cancel to stop the installation procedure at any time.  
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14. Click the Finish button, as shown in Figure 2.9.  
NOTE 

The ProcessView installation automatically installs Microsoft® Visual Basic® for Applications 
(VBA). If you are using the Unicode version of ProcessView for international language-switching 
capability, the installation will give you the option of installing Microsoft Arial Unicode Font 

 

Figure 2.9. Installation Complete 

 

Uninstalling ProcessView  
The ProcessView software can be uninstalled (removed) from the system, with all of your project-
related files left intact. 
Note:  If your operating system requires a login (e.g., Windows NT), you need to log in with 
administrator capability to uninstall. 
To uninstall ProcessView: 

1. From the Windows Start menu, select Settings > Control Panel. 
2. Double-click on Add/Remove Programs, as shown in Figure 2.10. 

 
Figure 2.10. Control Panel 
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3. From the list of programs that you can remove, select Smar ProcessView, as shown in Figure 
2.11. 

4. Click on Change/Remove to remove ProcessView and all of its components. 

 
Figure 2.11. Add/Remove Programs Properties 

 

5. When the files are removed, the uninstall program will indicate that the process is complete.  
Click OK. 

NOTE 

Uninstalling ProcessView Enterprise Software (or its components) will not uninstall the Licensing 
software. Your valid license will remain activated on your PC 
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ProcessView Software Licensing 
Introduction 

ProcessView software products use a software-based licensing scheme.  An activated license is 
required to use the software in full production mode.  This license designates which products may be 
used, as well as the I/O (Input/Output) point-count limit used in the system. This chapter explains the 
concepts of the software licensing and shows how to install and activate the license. For complete 
information about Licensing, please refer to the Smar Software Licensing Help documentation on the 
ProcessView product CD. 
Note: The system will run in a two-hour Demo mode without a site key enabled. 
Note: ProcessView version 5.x and 6.x software licenses must be upgraded to work with 
ProcessView version 7.0 or subsequent versions of ProcessView. 
Note: If you wish to upgrade your Smar Software License, simply install the new version over the 
existing version. It is NOT necessary to uninstall the old version before installing the new version. 

Configuration and Runtime 
There are two distinct modes of operation within the ProcessView software modules: configuration 
and runtime.  
Configuration is the product’s capability to let you configure the system--to create graphic displays 
in GraphWorX, for example, define which data to log in TrendWorX, and configure which OPC points 
to monitor for alarming in AlarmWorX, etc.  Many refer to Configuration mode as "Development" 
mode, since the entire project is designed and developed in this mode. Configuration mode in 
ProcessView does not require an installed software license.  You may develop your system on any 
machine. 
In Runtime mode, modules communicate with the actual I/O (Input/Output), talk to network nodes, 
and animate the documents made by using Configuration mode. 

ProcessView Demo Mode 
Without a valid license installed on your PC, it is still possible to enter Runtime mode (described 
above). The software will check for a valid software license key on initialization. If none is found, 
ProcessView runs in Demo mode. It has the following limitations: 

• It will only permit Runtime mode for two hours. 

• Only 32 OPC tag connections (points) will be updated. 
Running past the two-hour limit generates a message stating that the demo time has been 
exceeded.  You must then exit.  On restarting, you will get another two-hour block of time in which to 
run.  If there are more than 32 tags on a particular screen, gray stars (or whatever is configured as 
the Point Failure character) will appear in place of the actual I/O data. 
If you intend to run in Demo mode, skip to Chapter 4. 

Installing Smar Software Licensing 
You must install and run the Smar Software Licensing before you can run ProcessView software in 
Windows in non-demo mode. A Software License Site Key will be generated to handle licensing of 
ProcessView without requiring a hardware protection key. Licensing encrypting information is stored 
deep within the Windows systems.  See the section below for further details on activating the 
license.  This section first details how to install the software from the CD.  
Note:  Set the System Date and Time properly before installing the Software License Utility. Setting 
the time and/or date by more than an hour after the installation will affect any time-limited Licenses 
(such as the Temporary 30-day Activation). 
Note: If your operating system (e.g., Windows NT) requires a login name, you must log in as 
"Administrator" before installing the ProcessView Software Licensing. 
If you are installing the License Utility program as a continuation of the ProcessView installation 
covered in the previous chapter, skip to Step 4 below. 
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1. Before installing Smar software, be sure that all other applications, such as Microsoft Office or 
any antivirus software, are closed and/or disabled. 

2. Insert the ProcessView product CD into the CD-ROM drive. 

3. You will see the CD introduction and the main menu. (If Autorun is enabled on your system, the 
CD introduction starts automatically. Otherwise, browse to your CD drive and run the "RunMe.bat" 
file. Select Software from the menu. 

4. Select Licensing from the software selection menu. 

5. The Software License installation starts and displays a Welcome screen, as shown in Figure 
3.1. Click Next to continue. 

 
Figure 3.1. Welcome Screen 

6. If you have a previous version of the ProcessView License Utility installed, a notice appears as 
shown Figure 3.2. By installing the ProcessView 7.0 License Utility, you will no longer be able to run 
the 5.x and 6.x versions of ProcessView. If you have an existing Site Key for 5.x or a 6.x, a 
temporary 30-day license will be authorized for ProcessView 7.0. Click Yes to continue. 

 
Figure 3.2. License Utility Version Notice 
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7. In order to proceed with the License Utility installation, you must acknowledge that you have 
read the version compatibility notice that was displayed in the previous screen. Check the check box 
and click the Next button to continue, as shown in the Figure 3.3. 

 
Figure 3.3. Acknowledging the License Utility Version Warning 

8. The Software License Agreement appears, as shown in Figure 3.4. If you accept the terms of 
the agreement, click Yes. 

 
Figure 3.4. Software License Agreement 

9. The User Information dialog box appears, as shown in Figure 3.5.  Type in your name and 
your company's name, and then click Next. 
10.  
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Figure 3.5. User Information Dialog Box 

11. Choose the destination directory for the installation, as shown in Figure 3.6. This defaults to 
\Program Files\Smar\SoftLic. If you want to install the License Utility in a different directory, click 
Browse. Click Next to continue. 

 
Figure 3.6. Choosing the Installation Directory 

12. The setup will also create a program folder and copy all the shortcuts related to the License 
Utility into that program folder. The default program folder is Smar Software Licensing. You can 
specify a different folder if you want, as shown in Figure 3.7. Click Next to continue. The setup will 
start copying files to your computer and will display the status associated with the memory, disk 
space, and percentage of information copied. 



Getting Started 

3.5 

 
Figure 3.7. Select Program Folder 

13. Read the important notice, as shown in Figure 3.8. Click Yes to continue. 

 
Figure 3.8. License Utility Version Information 

14. In order to complete the License Utility installation, you must acknowledge that you have read 
the notice that was displayed in the previous screen. Check the check box and click the Next button 
to continue, as shown in Figure 3.9. 
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Figure 3.9. Acknowledging the License Utility Version Warning 

15. Setup is now complete, as shown in Figure 3.10. Click the Finish button to exit the installation 
wizard. You may be asked to restart your computer before running the SMAR License Utility.  

16. Note: You must now run the License Utility and register your software license in order to use 
ProcessView or any of its components.  For more information, see the section below called Running 
the License Utility. 

 
Figure 3.10. Setup Complete 

Running the License Utility 
The ProcessView Software License Utility provides full authorization to any of the purchased 
ProcessView products and its available options.  
To launch the License Utility from the Windows Start menu, select Programs > Smar Software 
Licensing > License Utility.  (This program, linked to the executable file GenLic32.EXE, may 
already have been started if you checked the box to launch it after installation.) 
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Temporary Authorization of ProcessView System 
The first time you run the License Utility, it will search your computer for a valid license, without 
finding one. It therefore presents the message shown in Figure 3.11. Click OK to proceed with the 
authorization. 

 
Figure 3.11. License Not Found Message 

If you are running the License Utility for the first time before authorizing your license on a computer, 
a dialog box for the Temporary License Authorization appears, as shown in Figure 3.12. This 
allows you to use Smar products immediately, for up to 30 days while you are completing the 
registration process.  The temporary licensing is a one-time license and is for a period of 30 days. 
This can be used for product evaluation and trial purposes. To execute the temporary license, click 
Yes. If you want to transfer a license to the PC, click No. If you want to continue to run in 
demonstration mode, click Exit. 

 
Figure 3.12. Temporary License Authorization 

This will enable the temporary license, and the License Utility will open, as shown in Figure 3.13. 
Note: If you are upgrading a previous version of the License Utility and already have a 
ProcessView 5.x or 6.x license, selecting YES will convert the ProcessView 5.x or 6.x license 
to a temporary 30-day license of the same configuration. 
Note: Please refer to the Smar Software Licensing or Getting Started Help documentation on the 
ProcessView product CD for details about registering, authorizing, transferring, and terminating an 
Smar software license. 

 
Figure 3.13. License Utility Screen 
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Registering for a Software License 
To authorize a permanent license, you must get a Site Key, which is a unique "software key" 
number that unlocks the runtime licenses for your site. There are two options to register and obtain a 
Site Key for the PC running the License Utility. Regardless of the method selected, the registration 
and license of Processview product(s) is achieved using the following process: 

17. Identify all products that will run on the PC, as well as the Site Code (to be generated during the 
registration process) for the PC. 

18. Smar validates the purchase of the products to be installed by using the provided Product 
Registration Number(s) shipped with the purchased CD.  Once validated, SMAR generates and 
returns a corresponding Site Key number that will activate the proper products for use on this PC. 

19. Select Authorize License from the Actions menu, and enter the provided Site Key number in 
the ProcessView License Authorization dialog box to activate the license, as shown in the Figure 
3.14. 

 
Figure 3.14. ProcessView License Authorization 

In the License Utility, begin the process of obtaining your site key by selecting Register for a 
License from the Actions menu. This opens the Registration Method dialog box, as shown in 
Figure 3.15. 

 
Figure 3.15. Selecting a Registration Method 

Fax / E-mail Registration 

Instead of connecting to the Internet (either from the installation PC or another one as described 
above), you apply for a software license via e-mail or fax. You specify the products to be installed on 
your PC and then send the generated information via fax or e-mail to SMAR, as described below. 

20. If the Fax / E-mail method is selected, the ProcessView Registration Information dialog 
appears, as shown in Figure 3.16. The Site Code generated for your computer by the License Utility 
is displayed at the bottom. Enter your name, address, city, phone number, etc., in this dialog box, 
and then click OK. The License Utility automatically saves this information into the Registration file 
(Register.dat) in the path where you have installed the License Utility. 
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Figure 3.16. ProcessView Registration Information 

21. The ProcessView Product Registration dialog box is displayed, as shown in Figure 3.17.  
There are two options, depending on whether the products have already been purchased and 
shipped with a labeled Product CD.  If the products to be installed on this PC have already been 
purchased, enter the Product Registration ID number(s) provided with the CD case(s) in the field(s) 
provided. Then click Accept. The next dialog box to appear will be the Registration Process 
Completed dialog box. Skip to Step 4 below.  

22. If you have not yet purchased the software products and, therefore, do not yet have the CDs 
with the sticker label bearing your Registration Numbers, click Skip to proceed to the next dialog 
box.   

 
Figure 3.17. ProcessView Product Registration 

23. In the New Purchase of Products dialog box, shown in Figure 3.18, will be displayed next if 
this is a new purchase or if the Product IDs are not available.  This dialog box does not require that 
the Registration IDs have been specified because the ID uniquely identifies the product(s) to be 
installed. Select the quantity and type of products to be installed and licensed on this PC and click 
OK. 
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Figure 3.18. New Purchase of Products 

24. Finally, the ProcessView Registration Process Completed dialog box is displayed, as shown 
in Figure 3.19. You may now choose which method you prefer to use to send your information to 
Smar. 

 
Figure 3.19.Registration Process Completed 

25. After receiving this information from you, the SMAR Order Processing Department will provide 
you with the unique Site Key for your system via fax or e-mail.  Once you have your Site Key, you 
can authorize your software license (see the section Authorizing Your Software License). 

Authorizing the Software License 
Once you have your Site Key (from either the Web site or from the fax/e-mail form received from 
Smar), you are ready to authorize your license. When you select Authorize License from the 
Actions menu of the License Utility, the ProcessView License Authorization dialog box appears, 
as shown in Figure 3.20. 

 
Figure 3.20. License Authorization 
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This dialog box displays your Site Code. Type the Site Key number received from Smar in the Site 
Key field. If, while using the same PC, you have obtained the number from the Smar Web site, paste 
the number into the Site Key field. Click Update to have your license authorized. You can now view 
the enabled software license by selecting View License from the Actions menu bar of the License 
Utility. 
Note: If you had an existing license to begin with, clicking Update will overwrite your existing 
license, either by replacing or appending/updating it with new products. 

Viewing the Software License 
To view the software license, select View License from the Actions menu of the License Utility. 
This opens the ProcessView License View dialog box, shown in Figure 3.21, which displays the 
current license information, including: 
• Type of license 
• Restrictions on the license 
• Number of copies licensed (allowed and used)  
• Number of Clients Units supported by the license  
• Site Code and Site Key 

 

 
Figure 3.21. Viewing the Software License 

If the license is temporary, the Site Key field will display Temporary Authorization, and there will 
be a unique Site Code generated by the utility based on your computer hardware. 
Users of Pocket ProcessView must purchase licenses for simultaneous connections between a 
desktop PC and Pocket PCs or CE devices. When a user purchases Pocket ProcessView and 
installs it on a desktop PC, two simultaneous Pocket PC connections will be available to that user 
from the desktop PC. If the user decides that more Pocket PC connections are needed, the user 
must purchase more Pocket PC connections in packages of five connections. 
The ProcessView License Utility detects how many Pocket PCs are connected to the desktop PC. If 
the maximum number of connections has been made, no new connections will be allowed to the 
desktop PC. For example, during one connection a Pocket PC can be running Pocket TrendWorX, 
Pocket AlarmWorX, and Pocket GraphWorX simultaneously. If any of those applications are running, 
the connection is active. 
For Pocket PCs and other CE devices, the License Server runs on the desktop PC connected over 
Ethernet via GenBroker. Thus, if a user has a license that allows for two connections and has two 
Pocket PCs connected at the same time, both Pocket PCs can be running Pocket TrendWorX, 
Pocket AlarmWorX, and Pocket GraphWorX simultaneously. Then if another Pocket PC tries to 
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connect to the GenBroker server on the desktop PC where those two licenses are located, it will be 
denied. 
Note: Please refer to the GenBroker help documentation for information about assigning a node or 
IP address to a remote License Server. 

Transferring a Software Key License 
You can use either a floppy disk or the Web Licensing Site to transfer a license.  You can transfer a 
software license from one PC to another, or a single copy of the software license if multiple copies 
exist on the same PC. The License Utility must be installed first on the target PC, so you can 
perform the license transfer.  

Transferring Licenses Using a Floppy Disk 

License transfer requires that the target PC is an unauthorized site. To transfer a license from one 
PC to another, do the following: 

1. On the target computer, select Transfer License from the Actions menu of the ProcessView 
License Utility to generate registration files on a floppy disk. This opens the ProcessView License 
Transfer dialog box, shown in Figure 3.22. 

 
Figure 3.22. Transferring a License 

2. At the target PC, a floppy disk has to be prepared for receiving a license. Format the floppy 
disk using the target computer. If you do not have a formatted floppy disk, you can quit the 
License Transfer dialog box and run it later. 

3. Select the Destination PC which is about to receive the license option on the License 
Transfer dialog box. Notice that Step 1 of the dialog box is enabled. The path will default to 
A:\. If your floppy disk drive letter is different, you can type it in the path field (for example B:\). 

4. Click the Register Transfer button. This will prepare the floppy disk for transfer. 
5. Insert the prepared floppy disk in the source computer and run the License Utility. Select 

Transfer License from the Actions menu of the License Utility and select the Source PC 
which already has license installed option. Notice that Step 2 in the dialog box is now 
enabled. The path will default to A:\. If your floppy disk drive letter is different, you can type it in 
the path field (for example B:\). 

6. Click the Transfer License Out button on the dialog box. This will transfer the license from the 
source PC to the floppy disk. 
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7. Select Transfer License from the Actions menu on the target computer to transfer 
the license from the floppy disk to the target computer. 

8. Click the Transfer License In button now. This will transfer the license from the floppy disk to 
the target computer. 

9. Restart your target computer for the changes to be effective. 

Transferring Licenses Using the Web Site 

26. You can transfer a license by first killing it (described in the next section) on one PC in 
conjunction with the Web Authorization Site (thereby putting the license back onto the Web), and 
then re-authorizing it on the new PC.  The Web site acts as an intermediary storage facility for the 
license, making it easy to transfer licenses between PCs that are physically far apart. 

Killing a Software Key License 
To kill or delete the existing software license: 

27. Select Kill License from the Actions menu in the License Utility. Using this option, you can 
remove the current software license from the current machine. You also need to contact the SMAR 
Order Processing Department to get a special password for killing your license. A warning message 
will be displayed on the screen as shown in Figure 3.23. If you kill your license, you need to get 
a new license from SMAR to restart your ProcessView product. 

 
Figure 3.23. Killing a Software Key License 

28. Click OK to continue or Cancel to exit. Clicking OK will display another warning message. If the 
license you are killing is an authorized time-limited license, a message appears as shown in Figure 
3.24. 

 
Figure 3.24. Killing a Time-Limited License 

29. If the license you are killing is a 30-day license or a permanent license, a message appears as 
shown in Figure 3.25. 

 
Figure 3.25. Continue With License Termination 

30. Clicking OK will display the Kill and Remove License dialog box, as shown in Figure 3.26. Click 
Cancel if you do not want to continue. Enter your name, the date, and the password you received 
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from Smar to kill the license on the above dialog box, and then click OK. Click Cancel if you do not 
want to kill your license.  

31. NOTE: This is the last step before you can exit without killing your license.  

 
Figure 3.26. Kill and Remove License 

A dialog box will appear to warn you of this danger, as shown in Figure 3.27. If you wish to proceed 
with killing your license, click OK. 

 
Figure 3.27. Final Warning Message Before License Termination 

33. A dialog box containing the Kill Confirmation Code will appear, as shown in Figure 3.28. Click 
OK.  
34. Note: You can copy the code in the Kill Confirmation Code field and paste it onto the Web 
page.   

 
Figure 3.28. Site Key With Kill Confirmation Code 

35. Upon successful deletion, a file called "KILL.TXT" will be created in the "Softlic" directory, which 
has the name, date, and last authorized key and confirmation code. A message will appear 
informing you that the file has been created, as shown in Figure 3.29.  
36. Keep this file! You will have to use the name, date, and last authorized key and confirmation 
code that it contains to confirm that you've killed your license (either via our Order Entry Department, 
or from the Web site).   

 
Figure 3.29. Message Confirming Creation of KILL.TXT File 

Note:  If you uninstall the Software License Utility, it will delete this KILL.TXT file. So make sure to 
copy this file or note the confirmation code before uninstalling the Software License Utility. You also 
need to give this code to Smar for the license removal process to be complete. 
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Note:  Also, a time-limited license CANNOT be credited back to the Web-based License Generator 
using a Kill Code.  You must call the Smar Order Processing department. 
Note:  Simply uninstalling ProcessView Enterprise Software (or its components) will not uninstall the 
Licensing software. Your valid license will remain activated on your PC. 

GFW Compatibility 
The ProcessView Software Licensing Site Key can coexist with a ProcessView™ for Windows 3.5 
(GFW) 16-bit product if already installed for Windows NT.  They are two mutually exclusive software-
licensing utilities.  Note that the  ProcessView protection key does not authorize GFW to run, and 
the GFW protection key does not authorize  ProcessView to run; each has its own mechanism.  In 
other words, you cannot simply copy the license files from one directory to another and expect the 
system to work. Simply install each respective licensing utility to enable both product families. 

Site Keys and File Maintenance 
The software Site Key handles licensing of  ProcessView without requiring a hardware protection 
key. Licensing encrypting information is stored deep within the Windows systems. If no  
ProcessView authorization is present, it will automatically run in Demo mode for two hours. 
Note: Set the System Date and Time properly before installing the Smar License Utility. Changing 
the time and date may affect time-limited Licenses. 
Upon successful installation of  ProcessView, the installation wizard automatically creates a directory 
for the  ProcessView Software Key licensing system. By default, the files are copied to the following 
path:  
…Program Files\Smar\Softlic 
This directory contains the PROCVIEW LICENSE.exe utility used for any  ProcessView system 
licensing transactions along with the Licensing files themselves.  
For Windows NT, a  ProcessView special service is installed that runs at startup and takes care of 
all the support needed to start the software protection system.   
Note: Tampering with the installation directory or  ProcessView files might accidentally destroy the 
license. 
The "Softlic" directory also contains the following files among other files: 
• PROCVIEW LICENSE.RST 
• PROCVIEW LICENSE.ENT 
• PROCVIEW LICENSE.KEY 
• PROCVIEW LICENSE.KY2 (PROCESSVIEW Version 6.x only) 
• PROCVIEW LICENSE.41S 
These files give the user a license to use ProcessView, and they contain encrypted information 
relating to the PC used, options the user is allowed to activate, and file system/directory.  If the 
ProcessView directory is renamed after the license has been granted, the software protection key 
will NOT recognize the license under the new directory name. It is also advisable not to tamper with 
the system's clock if using a time-limited license.  Setting the time back more than one hour will 
invalidate the license. 
Note: Ensure there is at least 1 MB of free disk space at all times on the hard drive the license is 
installed on.  If the disk becomes completely full, the software license may be lost. 
Note: If you are using Norton Speed Disk to reallocate disk clusters, the following procedure must 
be followed to prevent loss of the ProcessView Software License. 
1. Open Speed Disk and choose File > Options > Customize > Unmovable Files. 
2. Specify that the *.ent, *.rst, *.key, *.ky2 and *.41s files cannot be moved. 
 
Ensure there is at least 1 MB of free disk space at all times on the hard drive the license is installed 
on.  If the disk becomes completely full, the software license may be lost! 
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 Chapter 4 

4.1 

OPC Server Quick Start 
Introduction 

ProcessView "Plugs and Plays" with the powerful open communication architecture of OPC (OLE for 
Process Control). An overview of OPC can be found in Chapter 1. 
Since there are hundreds of OPC servers available, each with variations on the steps for using their 
configuration tools, it is not possible to provide exact details for the specific server you will use for 
your project. Instead, this chapter provides a step-by-step guide for creating OPC tags using the 
Smar Simulator OPC Server, which is automatically installed when you install ProcessView. 
The tags created in this chapter are used in the subsequent "Quick Start" chapters in this "Getting 
Started" manual.  Although you will ultimately use the actual OPC server connected to your real I/O, 
you should still complete the steps presented here for the sake of successfully completing the 
following "quick start" tutorials in this manual. 

Starting a New OPC Simulator Project 
The Smar OPC Simulator should already be installed on your machine in conjunction with 
ProcessView. If it is not on your machine, install it from the PROCESSVIEW CD now. 
To launch the Smar Simulator OPC Server from the Windows Start menu, select Programs > Smar 
ProcessView > OPC Simulator.  
This will open the configuration screen for the OPC Simulator, as shown in Figure 4.1.  Note that 
there are definitions already created for this server. Various portions of the GEN32Demo use these 
tags. As such, you should leave these configurations intact so the various examples used in the 
GEN32Demo will function properly. 

 
Figure 4.1. OPC Simulator Configurator 

The names in the left pane of the window (e.g. Disk IO, Global Variables, Recipe 
Storage, Simulate PLC) represent simulated "devices."  In the real world, "devices" could 
mean "Programmable Logic Controllers (PLCs)," "I/O Boards," or "Sensor Networks," etc.  
The first step, then, is to create our own simulated device to hook up to the simulated 
network of I/O: 
1. From the Add menu, select New Device, as shown in Figure 4.2. 
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Figure 4.2. Creating a New Device 

2. In the Device Properties dialog, type in the name "PLCSim" and then click OK, as 
shown in Figure 4.3. The new PLCSim device will appear in the tree control of the 
Configurator. 

 
Figure 4.3. Device Properties 

Creating Groups 
With Smar OPC Servers, you can organize your I/O tags into convenient folders, making 
them easy to work with, connect to, view, and manage, etc.  For this quick start, you will 
create two groups: 
Make sure the newly created PLCSim device is highlighted, so the group you are about to 
create is associated with that device.   
1. Right-click the PLCSim device and select New Group from the pop-up menu, as 

shown in Figure 4.4.  

 
Figure 4.4. Creating a New Group 

2. This opens the Group dialog box. Name the group “Temperatures," as shown in 
Figure 4.5.  Click OK. The new group will appear under the PLCSim device. 
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Figure 4.5. Naming the New Group 

With this OPC server, you can actually create groups within groups.  This hierarchical 
organization of groups makes it even easier to organize your I/O.  Simply select the 
group/folder you wish to create another group in, and select New Group from the Add 
menu.  
In this case, you will add another group at the "root" level of the device: 
1. Right-click the PLCSim device and select New Group from the pop-up menu. (Note: If 

you do not first click on PLCSim, the new group is added as a sub-folder to the 
"Temperatures" group.) 

2. In the Group dialog box, give this second group the name "Levels."  Click OK. Your 
screen should look similar to the one shown in Figure 4.6. 

 
Figure 4.6. Selecting the Device for the Second Group 

Creating Tags 
The Smar Simulator OPC Server allows you to create “dummy” tags, which can be used 
in a variety of ways, including: 
• Testing your system  
• Global variable storage (accessible from any OPC client on the network) 
• Recipe storage 
• Operator manual-entry data storage 
You will create several tags for use in the "Quick Start" chapters: 
1. Right-click the Levels group and select New Tag from the pop-up menu, as shown in 

Figure 4.7. 
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Fig. 4.7. Adding a New Tag to the "Levels" Group 

2. This opens the Tag Properties dialog box, as shown in Figure 4.8. Change the 
following parameters: 
• Name: Tank 1 
• Description: Water Level 
• Simulation Signal:  Sine 
• Data Type:  FLOAT 

 
Figure 4.8. Tag Properties 

3. The OPC specification also provides for passing OPC clients the scaling used for each 
OPC tag. This aids in setting up ranges for animated graphics, trend logging scaling, 
etc. You will now add scaling to this tag. Under the Scaling section, check the Enable 
check box, and then click on the Settings button.   

4. The Tag Process Settings dialog box appears, as shown in Figure 4.9. The sine 
wave signal you have configured will go from -1 to 1.  Fill in the fields as shown in 
Figure 4.9, so this scales to 0 to 100 meters. Click OK.   
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Figure 4.9. OPC Tag Scaling 

5. The Tag Properties dialog box now appears as shown in Figure 4.10. Click OK to 
save this tag. 

 
Figure 4.10. Defining the Tag Properties 

Next, you will add a several tags to the Temperatures group/folder, using a special 
feature of our OPC servers.   
1. Right-click the Temperatures group and select New Tag from the pop-up menu, as 

shown in Figure 4.11. 

 
Figure 4.11. Adding a New Tag to the "Temperatures" Group 

2. This opens the Tag Properties dialog box, as shown in Figure 4.12. Change the 
following parameters: 

• Name: T 
• Enable Scaling: 0 to 100 scales to 32 to 212 Deg. 
Your tag should appear as shown in Figure 4.12. This is simply a “base tag," i.e., one that 
you will “multiply” to produce several tags. Click OK. 



OPC Server Quick Start  

4.6 

 
Figure 4.12. Base Tag 

3. Next, you will take this base tag and multiply it to create a series of OPC tags.  To do 
this, first select the tag T by clicking on it in the right-hand window frame, then choose 
Multiply from the Add menu, as shown in Figure 4.13. 

 
Figure 4.13. Multiplying a Base Tag 

4. Set the Number of tags to 9, as shown in Figure 4.14. Click OK.   

 
Figure 4.14. Multiply Tag Dialog Box 

5. This creates 9 tags, named "T001," "T002," "T003," and so on.  You can delete the first 
base tag, "T," if you wish, by right-clicking on it and selecting Delete from the pop-up 
menu. 

6. The final step is to select Save from the File menu to save your changes.  
There are other features in the Simulator OPC Server, such as Monitor Mode (for viewing 
the OPC values without requiring a separate OPC client), importing and exporting tags to 
CSV files, etc. For more information, please see the Simulator OPC Server Help 
documentation. 
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GraphWorX Quick Start 
Introduction to GraphWorX Quick Start 

This chapter serves as a "mini-tutorial" for GraphWorX, the HMI module in ProcessView. There are 
dozens of tools with hundreds of parameters and combinations to create powerful graphics. The 
intent of this chapter is not to go through every combination and permutation, but to walk through a 
few fundamental concepts at least sufficient enough to get a project started. 

The next two chapters ("TrendWorX Quick Start" and "AlarmWorX Quick Start") will also build 
on the example screen developed in this chapter, showing how to add live trending of data and 
alarm information.  Please be sure to follow each of the steps outlined. 

Starting the Project 
To start the project, first launch GraphWorX from the Windows Start menu by selecting Programs > 
Smar ProcessView > GraphWorX > GraphWorX. 

1. In GraphWorX, select Application Preferences from the Format menu, shown in Figure 5.1.  

 
Figure5.1. Selecting Application Preferences in Format Menu 

2. Select the Compatibility tab and then check Dockable as Symbol Toolbar option in the 
Symbol Library Style. 
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Figure 5.2. Application Preferences toolbox 

3.  The following box will be open. Click on the Combo Box and choose Automotive > Robot > 
ABB1 Robot. 
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Figure 5.3. Symbols Combo Box 

4. Drag and drop the symbol to the display window.  
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Figure 5.4. New Display Window 

 

Process Points 
The first step is to show live values coming from the OPC Simulator Server, using the tags created 
in OPC Server Quick Start.   

1. Click on the Process Point  (PPT) dynamic button located on the Dynamics toolbar near the 
bottom of the screen, as shown in Figure 5.6. 

 
Figure 5.5. Process Point Dynamic Object 

2. The cursor turns into "??????" and looks for a place to draw the process point.  Click on the 
area just to the top right of the robot arm, as shown in Figure 5.5. 

 
Figure 5.6. Process Point Dynamic Object Placement 
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3. This opens the Property Inspector dialog box.  Every object within GraphWorX has one of 
these.  It is here that customization of the object and dynamic properties can be made.  The first tab 
at the top is for the Visible parameters of the object (in this case it is a Text object).  Any dynamic 
animations then appear as additional tabs (in this case, the PPT/DE tab dynamic is already attached 
to the Text object).  In the PPT/DE tab, click the OPC Tags button, as shown in Figure 5.7. 

 
Figure 5.7. OPC Tags Button in Property Inspector 

4. The Tag Browser appears, as shown in Figure 5.8.  With it, ProcessView components can 
browse to any OPC Server, from any company, on any node on the network (using the Internet and 
the Network Neighborhood choices).  Navigate to the Structural OPC tag created in OPC Server 
Quick Start by expanding My Computer and clicking on Structural, as shown in Figure 5.8.  Click 
OK. 

 
Figure 5.8. Tag Browser 

5. To adjust how this live data appears, click the Text tab at the top of the Property Inspector 
dialog. Make the text centered, with a Sunken Frame, and a fill color of Gray, as shown in Figure 
5.9. Then click OK. 
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Figure 5.9. Text Tab Properties 

6. The process point is inserted into the display, as shown in Figure 5.10. Now duplicate the 
process point either by choosing the Copy/Paste or Duplicate commands from the Edit menu or by 
holding down the CTRL key as you drag the object.  Place this second process point below the first 
one, as shown in Figure 5.10. 

 
Figure 5.10. Two Duplicate Process Points Next to the Meter 

7. To open the Property Inspector for an object, simply double-click on the object.  You can then 
make changes to the object's parameters.  In this case, open up the Property Inspector for the 
second process point (below the first one), click on the PPT/DE tab at the top, click on the OPC 
Tags button and select the Ramp OPC tag created in OPC Server Quick Start.  The dynamic should 
appear as shown in Figure 5.11.  Click OK to complete this process point configuration. 

 
Figure 5.11. Second Process Point's Dynamic Connection  
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 Runtime Mode 
So far in this chapter, GraphWorX has been used only in Configuration (Development) mode.  In 
order to see the dynamics working, you must switch to Runtime mode.  Simply click on the 
Runtime menu (or press CTRL+M to switch modes).  GraphWorX then hides the development 
toolbars, makes connections to the OPC server(s) used in the display's dynamics, and begins 
updating the display with live data.  Notice that the process points you created are now displaying 
values, as shown in Figure 5.12. 

One of the features offered by GraphWorX is the ability to pop-up additional help information for 
objects.  For example, moving the mouse pointer over one of the process points shows the full OPC 
tag name for the dynamic connection, and its current value, in the pop-up ToolTip, as shown in 
Figure 5.12. 

 
Figure 5.12. Runtime ToolTips 

To return to Configuration mode, click on the Configure menu (or press CTRL+M to switch 
modes). 

Location Dynamic 
GraphWorX offers the industry's easiest-to-use location dynamic.   To demonstrate this: 

1. First, select the Ellipse/Circle drawing tool, as shown in Figure 5.13, and then draw a circle at 
the end of the copper piping by clicking and dragging the mouse to define the size of the circle.  

 
Figure 5.13. Circle/Ellipse Drawing Tool 

2. With the circle still selected (it has the resize handles shown around it), click on the Yellow 
square in the color toolbar to change the fill color used for the circle.  When complete, it should look 
similar to the illustration shown in Figure 5.14. 
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Figure 5.14. Bubble in the Pipe 

3. This circle will be used to indicate flow going through the pipe.  You must add an animation 
dynamic to this circle.  Whenever an object is selected, the Dynamics toolbar enables the 
various animation items that can be added to the object.  With the circle still 
selected, click on the Location/Slider Dynamic (to make the circle move through the pipe based on 
an OPC Tag: 

 
Figure 5.15. Location Dynamic 

4. The Property Inspector for the Location/Slider Dynamic appears, as shown in Figure 5.16.  
The Ellipse tab refers to the visible object to which this dynamic is attached.  Setting up the location 
dynamic is a simple three-step process if you click on: 

• First, click the OPC Tags button to assign this dynamic to an OPC item. (From the Tag 
Browser, select the Tank1 OPC tag created in OPC Server Quick Start.)   

• Second, click the Horizontal button (to define a multi-path animation). 

• Third, click the Set Limits button. 

The Property Inspector will then temporarily disappear, allowing a visual click-and-drag 
configuration of the location parameters used to define the path in which this circle will move. 

 
Figure 5.16. Location Dynamic Property Inspector 

5. Note that the circle has a set of dotted-rectangles around it.  Click on the circle, and drag it to 
the bottom of the tank, as shown in Figure 5.17.  The actual circle remains where it was originally 
drawn at the end of the pipe.  What actually moves when you drag it is the end point definition for 
the location dynamic.  A dotted line then connects the start and end locations. 
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Figure 5.17. Location Dynamic Start/End Limits 

6. With the path defined, double-click anywhere outside the dotted rectangle (or press the ESC 
key).  The Property Inspector dialog box will reappear.  Click OK to save the configuration 

7. Enter Runtime mode (CTRL+M) to see the circle travel through the pipe based on the OPC 
values for the OPC Tag established. 

Rotation Dynamics 
Now it is time to create a needle for the meter and have it rotate with the OPC tag values.  To 
demonstrate this: 

1. First, in Configuration mode, select the Rectangle/Square drawing tool. Then draw a thin 
rectangle by clicking and dragging as shown in Figure 5.18. 

 
Figure 5.18. Rectangle Drawing Tool 

2. With the rectangle still selected, click on the Rotation/Dial dynamic (to make the rectangle 
swing based on an OPC tag), as shown in Figure 5.19. 

 
Figure 5.19. Rotation/Dial Dynamic 

3. The Property Inspector for the Rotation/Dial dynamic will appear, as shown in Figure 5.20.  
Note that the Rectangle tab refers to the visible object to which this dynamic is attached.  Setting up 
the rotation dynamic is a simple process: 

• First, click the OPC Tags button to assign this dynamic to an OPC item (select the Tank 1 OPC 
tag created in OPC Server Quick Start).   

• Second, click the Set Angles and Pivot button. The Property Inspector will then temporarily 
disappear, allowing a visual click-and-drag configuration of the rotation parameters. 
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Figure 5.20. Setting up a Rotation Dynamic 

4. Notice that the rectangle has a set of dotted-rectangles around it and a circle with a cross-hair in 
its center, as shown in Figure 5.21 A.  Click on the cross-hair circle, which designates the pivot 
point, and drag it to the bottom of the rectangle, as shown in Figure 5.21 B.   

 
Figure 5.21. Defining Rotation Pivot and Angles 

5. Next the Ending Angle is defined.  Click and drag the rectangle in Figure 5.21 B to the end of 
the meter marks, as shown in Figure 5.21 C.   

6. Finally, the Starting Angle is defined by dragging the remaining dotted rectangle to the meter 
mark start, as shown in Figure 5.21 D.   

7. Press ESC (or double-click) to get out of the rotation definition mode and return to the Property 
Inspector. Click OK to save. 

8. Double-click on the bitmap image of the meter to open its Property Inspector.  Check the 
Transparent check box, as shown in Figure 5.22, thereby making anything blue in the bitmap 
invisible and creating an irregularly shaped bitmap.  Click OK to save these changes. 

 
Figure 5.22. Making a Transparent Bitmap 

9. Enter Runtime mode (CTRL+M) to see the rotation working. 
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Color Dynamic 
GraphWorX offers two types of color dynamics: 

• Discrete Color Dynamic: The object changes from one color directly into another color based 
on a Digital signal (or Boolean expression).  More than one color change can be defined (e.g., a 
valve turning from gray to red on alarm, to yellow on warning, and to green when open, etc.). 

• Analog Color Dynamic: The object changes its color gradually, going through an entire 
spectrum of colors based on an Analog signal (or Analog expression) through its range of values.  
For example, use this to show continuous temperature change, having an object get brighter red as 
it gets hotter. 

This section walks through adding an Analog Color Dynamic to the light bulb so it can change color 
from gray to bright yellow while an OPC tag to which it is connected to changes values.  This 
animation should not change the color of the entire light bulb object, just the glass dome on top. 

The light bulb is actually a bunch of symbols grouped together (clipart that was imported as a 
vector-based Windows Metafile and then converted into native GraphWorX objects). So your simply 
clicking on the light bulb and adding the dynamic would not be the correct thing to do.  What you 
need is a way to select only the glass portion of it. 

Although ungrouping such an object is possible, note that attached to this light bulb group is a Pick 
dynamic already configured for popping up a menu to change values (more on this later).  
Ungrouping the object would destroy that animation. 

Luckily, GraphWorX allows you to edit objects that comprise a symbol without first having to 
ungroup that symbol, thereby keeping any dynamics associated with the group intact, and saving 
development time.   

The steps to complete this project are as follows: 

1. First, in Configuration mode, right-click on the light bulb and select Edit Symbol from the pop-
up menu, as shown in Figure 5.23.   

Note: The object's eight "size handles" are blue.  This indicates that a dynamic is tied to this object.  
The handles are blue when the object does not have a dynamic at that level. 

 
Figure 5.23. Editing a Symbol 
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2. A solid line surrounds the border of the symbol, indicating that sub-symbol editing is taking 
place.  Click on the gray glass portion of the light bulb to select it, as shown in Figure 5.24. 

 
Figure 5.24. Sub-Symbol Editing 

3. Click the Analog Color button on the Dynamic toolbar, as shown in Figure 5.25. 

 
Figure 5.25. Analog Color Dynamic Tool 

4. The Property Inspector for the Analog Color dynamic will appear, as shown in Figure 5.26. 
Click the OPC Tags button and navigate to the OPC tag 
"ICONICS.Simulator.1\SimulatePLC.OUTPUTS.FLOAT." This is a tag that has already been 
created.  It is important to link to this specific tag, since the various controls configured in this display 
to change the light bulb are already tied to this particular OPC tag. 

 
Figure 5.26. Analog Color Dynamic Property Inspector 

5. Click on the End Color field and select Yellow.  Then click OK to save the configuration. 

6. To get out of sub-symbol editing, either double-click outside the symbol boundary, or press the 
ESC key. 

7. Enter Runtime mode (CTRL+M) to see this color change work.  Details on changing the 
underlying OPC value are covered in the next section. 

Writing Values to OPC Tags 
GraphWorX offers a variety of ways to write values to OPC tags: 

• Data Entry Process Points 

• Radio Buttons 

• Push Buttons 

• Check Boxes 

• Sliders (Location Dynamic to slide an object) 
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• Dials (Rotation Dynamic to turn an object) 

• Pick Actions 

• Pop-up Menus 

• VBA Scripting 

See the example file in the Figure 5.27. 

 
Figure 5.27. Data Entry Examples 

Click on any of the three Radio buttons to download a preconfigured value to the OPC tag 
controlling the light bulb. Clicking on the light bulb itself opens a pop-up a menu offering these 
same choices.  Next, click on the Data Entry field. It has an automatic number pad configured 
to pop up.  Slide the knob to the right of the bulb to change the value. 
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Chapter 6 

6.1 

TrendWorX Quick Start  
Introduction 

TrendWorX is the Data Logging and Trending module in ProcessView. There are actually several 
components that make up this software package: 
• SQL Data Logger 
• Data Logging Configurator 
• Persistent (Background) Trending 
• Trend Viewer ActiveX for Live and Historical Trending 
• Database Reporting Tools 
Within each of these components are dozens of tools with hundreds of parameters and 
combinations to satisfy a wide range of applications.  The intent of this chapter is not to go through 
every combination and permutation, but to walk through enough fundamental concepts of the 
TrendWorX Viewer ActiveX to get a project started. 
For additional information on using TrendWorX, please refer to the GEN32Demo tutorials (see 
Chapter 4) or the TrendWorX Help documentation available on the ProcessView product CD.  
This chapter builds on the example display developed in the Chapter 6, showing how to add live 
trending of data.  If it is not already running, open the QuickStartWalkThru.gdf file in GraphWorX. 

Creating a Trend View 
The TrendWorX component for plotting live and historical data graphically on the screen is actually 
an ActiveX component.  It is therefore available not only within the TrendWorX container application, 
but in any ActiveX container.  In GraphWorX, the TrendWorX Viewer ActiveX can be inserted into 
the display by clicking on the TWXView32 button on the ActiveX toolbar, as shown in Figure 6.1. 

 
Figure 6.1. Inserting a TrendWorX Viewer ActiveX Control 

A trend window is placed on the screen, as shown in Figure 6.2.  Shrink it down and move it to fill in 
the right hand section of the screen, as shown in Figure 6.2. It's easiest first to move it so the lower 
right corner is at the desired location, and then simply use the upper left resize handle to position the 
opposite corner. 

 
Figure 6.2. Placement of the Trend Viewer ActiveX 
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Dragging and Dropping Data Sources 
GraphWorX has a feature called Drag Drop Data Source working together with the TrendWorX 
Viewer ActiveX. To see what it does: 
1. Double-click on the first process point you created in Section 6.3.  This opens the Property 

Inspector for the process point.  Click on the PPT/DE tab, and then check Drag Drop Data 
Source check box, as shown in Figure 6.3. Click OK. 

 
Figure 6.3. Drag Drop Data Source Configuration 

2. Repeat Step 1 for the second process point. 
3. Enter Runtime mode (click on the Runtime menu or press CTRL+M to switch modes). 
4. Click on the first process point and drag it into the TrendWorX Viewer ActiveX window, as 

shown in Figure 6.4. The OPC tag information is added to the Trend window, the scale is 
automatically set, and the data are plotted over time in the trend window. 

 
Figure 6.4. Drag Drop Data Source in Runtime 

5. Repeat Step 4 for the second process point, dragging the process point into the Trend Viewer 
window.  

Manipulating Trends During Runtime 
The TrendWorX Viewer ActiveX offers many runtime features.  This section explores just a few of 
them. 

Floating Toolbar 
While in Runtime mode, and with the two pens now added to the Trend window in the previous 
section, double-click on the plot area of the Trend Viewer. The Trend Viewer toolbar will appear, as 
shown in Figure 6.5. The buttons on this toolbar are used to work with the Trend window in 
Runtime mode.   
Note:  The toolbar can become disabled with security. 

 
Figure 6.5. Trend Viewer Toolbar 

Freeze Mode 
Clicking on the Hand icon in the floating Trend Viewer toolbar, as shown in Figure 6.6, causes the 
display to enter Freeze mode, whereby the trend information is frozen in the window (although it is 
still collecting data in the background). 
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Figure 6.6. Freeze Mode 

Data Details 
While in Freeze mode, click on the graph. With the mouse held down, drag across the trended data.  
A black bar appears, and as the mouse is dragged back and forth over the Trend window, the Detail 
window at the bottom shows the data values and times under the cursor.  Pressing the Cursor 
Forward and Cursor Back buttons on the floating toolbar is another way of adjusting which data 
details are shown. 
If you hover the mouse pointer over one of the data samples (over the circle surrounding the point), 
a pop-up window appears showing that data point's details, as shown in Figure 6.7.  This is handy if 
the details window is ever configured not to be visible. 

 
Figure 6.7. Details of Data Shown in Trend Window During Freeze Mode 

Zoom Data 
While in Freeze Mode, hold down the Shift key on the keyboard, and then click and drag a box area 
on the graph, as shown in Figure 6.8.  .  Upon releasing the mouse button, the graph automatically 
zooms and rescales the zoomed in area to fit the window. This process of "rubber-banding" a 
window with the mouse to zoom in can be repeated, thereby zooming in further. To zoom out, simply 
right-click anywhere in the zoomed area. 
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Figure 6.8. Zooming in on a Selected Area 

Trend Statistical Data 
Clicking on the Statistics button in the floating Trend Viewer toolbar opens the Trend Statistics 
dialog box, as shown in Figure 6.9.  Here statistics are shown for each pen being plotted.  This 
information can be saved to a CSV file, which can then be opened by Microsoft Excel, Microsoft 
Word, and various databases. 

 
Figure 6.9. Viewing Trend Statistics 

Pen Menu  
Right-clicking on a pen description in the Detail window opens a pop-up Pen menu, which offers a 
variety of options while in Runtime mode, as shown in Figure 6.10.  Try each of these menu items 
out to explore their use. 
For example, the Trend window by default only shows one range. The range is the list of numbers 
along the left-hand side of the Trend Viewer plot. However, each pen actually has its own range.  
(Configuring the window to show two or more different ranges simultaneously will be covered later in 
this chapter).  
To show the range for the second pen, right-click on the second pen and then choose Options > 
Show Range from the Pen pop-up menu, as shown in Figure 6.10. Notice how the range window 
changes from showing 0 to 10 and instead now shows 32 to 212, which was the range set up in 
Chapter 5 for this OPC tag. 
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Figure 6.10. Changing the Range Window 

There are many more features offered by TrendWorX Viewer ActiveX while in Runtime mode.  
Please refer to the TrendWorX Help documentation for more information. 
For now, exit Runtime mode so you can explore additional configuration parameters for the Trend 
Viewer. 

Configuring the Trend Window 
While in Configuration mode, double-click on the TrendWorX Viewer ActiveX.  The Trend Viewer 
ActiveX Properties dialog box appears, as shown in Figure 6.11.  Each of the various tabs 
contains a set of parameters for controlling the trend's operation. 
In the previous section, the range window was switched from showing the first pen's range 
information to the second pen's information.  From this dialog, it is possible to adjust the window to 
show both ranges at the same time: 
1. Click on the Ranges tab.  Change the Size field to Large. Change the Visible Ranges field to 
2, and then click Apply, as shown in Figure 6.11. Both ranges are now shown in the Trend window. 

 
Figure 6.11. TrendWorX Viewer ActiveX Properties: Ranges Tab 
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2. Then click on the Rates tab, as shown in Figure 6.12. Change the Data Collection Rate to 0 
seconds, 250 milliseconds, and then click Apply. 

 
Figure 6.12. TrendWorX Viewer ActiveX Properties: Rates Tab 

There are several other tabs in the Trend Viewer ActiveX Properties dialog box for adding/editing 
pens, changing which window elements are shown, grid configuration, trend type, and so on.  Click 
on each of these tabs to explore these options. 
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AlarmWorX Quick Start 
Introduction 

AlarmWorX is the alarm monitoring, logging, and reporting module in ProcessView. There are 
actually several components that make up this software package: 
• Alarm Server Configurator: Creates alarm definitions  
• Alarm Server: Main engine for monitoring alarms 
• Alarm Logging Configurator: Defines what alarms get logged to a database and/or printer 
• Alarm Logger: Enables printing and logging to a database  
• Alarm Container: Provides a container for the Alarm Viewer ActiveX (helpful for stand-alone 

applications) 
• Alarm Viewer ActiveX: Plug-in that shows live alarm information 
• Alarm Report ActiveX: Plug-in that shows historical alarm information from the logged database 
• Alarm Indicator ActiveX: Monitors alarm activity from virtually anywhere on your computer 

display 
• AlarmWorX Multimedia (optional): Plug-ins for enunciating alarms using various multimedia 

"agents," including pager, phone, fax, e-mail, and marquee. 
Within each of these are dozens of tools with hundreds of parameters and combinations to satisfy a 
wide range of applications.  The intent of this chapter is not to go through every combination and 
permutation. Instead it walks through enough fundamental concepts of the Alarm Viewer ActiveX 
and setting up an OPC tag to be monitored for alarms to get a project started. 
For additional information on using AlarmWorX, please refer to the GEN32Demo tutorials (see 
Chapter 4) or the AlarmWorX Help documentation available on the ProcessView product CD.  
This chapter builds on the example screen developed in the previous two chapters, showing how to 
add a live alarm viewer to that display.  If it is not already running, please open the 
QuickStartWalkThru.gdf file in GraphWorX. 

Creating an Alarm View 
The AlarmWorX component for showing live active alarms in a table is actually an ActiveX 
component.  It is therefore available not only within the AlarmWorX container application, but in any 
ActiveX container.  In GraphWorX, the AlarmWorX Viewer ActiveX can be inserted into the display 
by clicking on the AWXView32 button on the ActiveX toolbar, as shown in Figure 7.1. 

 
Figure 7.1. Inserting an Alarm Viewer ActiveX Control 

An alarm window is placed on the screen.  Move it and resize it to fill up the bottom section of the 
screen, as shown in Figure 7.2. It's easiest to move it first so the lower right corner is at the desired 
location, and then simply use the upper left resize handle to position the opposite corner.  Save the 
display file. 

 
Figure 7.2. Placement of the Alarm Viewer ActiveX 
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Alarm Viewer Runtime Operation 
Enter Runtime mode (CTRL+M).  As the alarm OPC client goes into Runtime, it connects to the 
AlarmWorX Server (this ActiveX by default connects to the installed examples) and sends a request 
that alarm monitoring begin; thus the AlarmWorX Server automatically starts up.  This not only works 
on the local machine, but with any OPC Alarm and Event server on the network! Once the alarms 
are being monitored, new alarms/events are posted to the Alarm Viewer, as shown in Figure 7.3.   

 
Figure 7.3. Alarm Viewer ActiveX in Runtime 

Alarm Colors   
By default, the Alarm Viewer is configured to show the alarms and events in the following manner: 
• Unacknowledged, active alarms are in white text on a red background.  These are new alarms 

that have not been acknowledged by an operator and are still actively in their alarm state. 
• Acknowledged, active alarms are in red text on a white background.  These alarms are still 

actively in their alarm state, but have been acknowledged by an operator (or have been 
configured to be auto-acknowledged). 

• Unacknowledged, return-to-normal messages are in dark green text on a white background.  
These alarms were in an alarm state, were never acknowledged, and then left the alarm state.  
Although the point is no longer in alarm, this message remains on the screen until it is 
acknowledged so operators know that an alarm did occur. 

• Operator tracking events are in black text on a white background.  These are used for events 
posted by the GenEvent Server, which tracks such items as operator set point changes, user 
login, and so on. 

These colors can be configured not only for these states, but also for various alarm priorities and 
more.  This will be demonstrated later in this chapter. 

Alarm ToolTips 
Hovering the mouse pointer over an alarm line in runtime causes a ToolTip to pop up.  By default, 
this ToolTip is configured to show any Help text configured for that alarm.  The contents of this 
ToolTip can be changed on the fly.  Simply right-click on an alarm line and select ToolTips from the 
pop-up menu, as shown in Figure 7.4. 

 
Figure 7.4.  Alarm Viewer Pop-up Menu in Runtime 

The above example shows the ToolTips submenu, with the black dot showing that Help is the 
current selection.  By selecting Context, the ToolTip will instead show the entire contents of the 
selected cell (row/ column).  Selecting Comment shows comments entered by users for that 
instance of that alarm (entered while acknowledging the alarm, as discussed in the next section).  
Alarm Line shows the contents of all visible columns for that alarm line.  None turns them off. 
Access to changing the ToolTips can be controlled via the Security Server. 
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Acknowledging Alarms 
To acknowledge an alarm on the screen in runtime, simply double-click anywhere in alarm line. To 
access advanced Alarm Acknowledgment features, right-click on an alarm line and select Ack 
from the pop-up menu, as shown in Figure 7.5. 

 
Figure 7.5.  Acknowledging an Alarm 

This opens the Alarm Acknowledgment dialog box, as shown in Figure 7.6. From here, operators 
can choose to acknowledge the following:  
• Point: Acknowledges all selected alarms 
• Global: Acknowledges all alarms in the system 
• Visible: Acknowledges all visible alarms 
• Filtered: Acknowledges alarms using the active alarm filter 
• Area: Acknowledges alarms associated within the selected alarm area 

Note: Selecting Events removes all event messages.  
Additionally, comments may be added.  These are posted to the Alarm Viewer, and can 
also be logged to the historical alarm database. 

 
Figure 7.6.  Alarm Acknowledgment 

Once an alarm has returned to normal and has been acknowledged, it is removed from the Alarm 
Viewer.  Thus, only items that require immediate attention are shown to the operators.  The 
Historical Alarm Report ActiveX control is used to view old alarms. 

Alarm Sorting 
The alarms are sorted, by default, in simple chronological order.  To change this, double-
click on any column heading.  The rows are then sorted in ascending order based on the 
values shown in that column.  By double-clicking on the same column heading a second 
time, they will be sorted in descending order. 
It is possible to sort by more than one column.  Right-click on an alarm line and select 
Sort from the pop-up menu.  This opens the Sort dialog box, as shown in Figure 7.7. Up 
to five levels of sorting and sub-sorting can be configured.  In the example in Figure 7.7, 
alarms will be sorted first by node name, then by time/date.  Thus, all alarms from a given 
computer (node) will be grouped together, which is convenient for a central alarm-viewing 
station on a network. 
The Default Sort order can be defined in Configuration mode. Security can prevent 
users from changing this order. 
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Figure 7.7.  Sorting Alarm Information 

Configuring the Alarm Viewer 
In Configuration mode, double-click on the Alarm Viewer ActiveX control.  This opens the 
Properties dialog box, as shown in Figure 7.8. 

 
Figure 7.8.  Alarm Viewer ActiveX Properties Dialog Box 

There are many parameters that can be modified, just one of which will now be covered.  Please 
refer to the AlarmWorX documentation for complete information about available configuration 
options. 
It is possible to configure not only the row colors based on alarm state, as mentioned earlier in this 
chapter, but also the Font and Flash properties.  They also can appear differently, based on the 
priority (also known as the "severity") of the alarm.  
To change how alarm rows appear: 
1. Click on the Row tab, as shown in Figure 7.9.   
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Figure 7.9.  Alarm Row Configuration 

2. Click on the Severity drop-down list and select 900-1000.  The window then shows the settings 
for all unacknowledged alarms with a severity/priority greater than or equal to 900.   

3. Click on the Configure button.  This opens the Set Row dialog box, as shown in Figure 7.10. 
Here you can change the Font, Colors, Flash, and Beep parameters.  Click OK when you are 
finished.   

 
Figure 7.10.  Alarm Row Configuration 

Configuring an Alarm Tag 
The AlarmWorX Configurator is used to define which OPC tags should be monitored by the 
AlarmWorX Server.  To launch the Configurator from the Windows Start menu, select Start > 
Programs > Smar ProcessView > AlarmWorX > Alarm Server Configurator. 
The Alarm Server Configurator opens, as shown in Figure 7.11.  On the left side of the window is a 
tree control of the defined alarm Areas  (also called "folders" or "alarm groups") and Alarm 
Configurations.  The right side of the configuration window shows the configuration details for the 
items selected in the tree control. 
AlarmWorX allows the configuration of multiple areas, each with its own set of tags and, possibly, 
sub-areas.  For example, click on the + symbol next to the Areas folder at the root of the tree 
structure.  All root-level alarm areas are shown, as shown in Figure 7.11. 
Next, click on the + symbol next to the folder for the area named Plant Area A (or, double-click on 
the folder icon).  The tree then expands to show several alarm tags already defined within this area, 
as well as an additional sub-area named Sub Area A.   To view the configuration of any tree item, 
simply click on it. 
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Figure 7.11.  Alarm Areas in the Server Configurator 

Alarm areas can be used in several ways.  For example, they can be used by the Alarm Viewer 
ActiveX to filter out which alarms will be shown in its active list (e.g., only alarms that occur in Plant 
Area B).  Alarms can be sorted by area with the Alarm Viewer.  Operators also have the opportunity 
to acknowledge all alarms within a given area.  It is also possible to tie dynamics in GraphWorX to 
the alarm status of an entire area (e.g., flash an object whenever any alarm within an area is active).  
There are other benefits as well.  Suffice it to say, the design of a good alarming scheme for any 
project should employ areas! 
Before explaining the quick steps for creating a new alarm tag, it is worth pointing out that the alarm 
definitions themselves are stored in a configuration database (by default, the file is Awx32Svr.mdb, 
which is a Microsoft Access database).  This makes it easy for project teams to share alarm 
definitions and distribute the alarming system across networks. 
Note: To create a new configuration database, select New from the File menu and follow the steps 
in the Configuration Database Wizard. 
To create a new tag: 
1. Right-click on the Default alarm configuration in the tree control of the Configurator and select 

New > Tag from the pop-up menu, as shown in Figure 7.12.   

 
Figure 7.12.  Creating a New Alarm Tag  

2. The properties dialog box for the new tag appears in the right-hand pane of the Configurator, as 
shown in Figure 7.13.  

3. In the Name field, give this alarm tag the name Tank Level Alarm. 
4. In the OPC Input 1 field, click on the arrow button and select OPC Tags from the pop-up menu. 

This opens the Tag Browser. Browse to the OPC tags created earlier in Chapter 5 and select 
SMAR.Simulator.1\PLCSim.Levels.Tank 1. Click OK. The tag now appears in the OPC Input 1 
field text box, as shown in Figure 7.13. 
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Figure 7.13.  General Alarm Tag Definition Fields 

5. In the General tab, enter the following parameters, as shown in Figure 7.13. 

• Enabled: 1 

• Base Text: "The Tank Level is" (This text, concatenated with the alarm message text to create 
the full alarm line, appears in the Alarm Viewer, is logged to disk, and is used by the optional 
AlarmWorX Multimedia package to send to pages and e-mails, etc.) 

Note: In the Help Instructions field, you can optionally enter the text that will appear in the alarm 
ToolTip. 
6. Click on the Alarms tab and then click the Limit button. The Limit field, shown in Figure 7.14, is 

used to set up the monitoring of an analog OPC tag (or "expression") and a maximum of four 
limit alarms. 

 
Figure 7.14.  Limit Alarm Tag Definition Fields 
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7. Enter a Lo limit of 200.  Whenever the tank falls below this level, the Lo alarm is triggered. 
8. Enter the Message Text for the Lo alarm as: "Too low. Open the inlet valve." 
9. Enter a Hi limit of 800.  Whenever the tank goes above this level, the Hi alarm is triggered. 
10. Enter the Message Text for the Hi Alarm as: "about to overflow!" 
11. Enter a Severity level for the Hi Alarm as 900.  (The higher the number, the greater the 

severity/priority of the alarm.) 
12. Enter the Return to Normal text for when the alarm clears and returns to normal as "now back 

to normal." 
13. Click the Apply button to save the changes to the database. 
With the fields entered as shown, return to the GraphWorX display project with embedded the Alarm 
Viewer ActiveX file and enter Runtime to view the newly configured alarm in action. 
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ProcessView Utilities 
Introduction 

ProcessView offers a host of applications to complement the core products of GraphWorX, 
TrendWorX, and AlarmWorX.  This chapter briefly introduces some of these utilities.  For further 
details on these and the rest of the products offered, please refer to the Help documentation.  

Security Server 
The Smar Security Server provides a variety of options for restricting operator actions during 
runtime, including: 
• Which points they can write to (change value). 
• Which files they can open. 
• Time sheets for defining when they can log in. 
• Password management. 
• Workstation access for logging in. 
• Client application action restrictions.  
Note: For additional information about configuring the Security Server, please refer to the Security 
Server Help documentation available on the ProcessView product CD.   
To define the security setup for your system, you must use the SMAR Security Configurator.  To 
launch it, choose Start > Programs > Smar ProcessView > Tools > Security Configurator. 
Enter a user name and password, as shown in Figure 8.1.  If this is the first launching of the 
Security Configurator, use the Administrator password designated during the installation process (by 
default, it is “SMAR”). 

 
Figure 8.1. Security Server Administrator Login 

When you log in, the Security Server Configurator screen opens. The Security Configurator 
consists of two separate panes. User Group definitions are in the left-hand side of the window, and 
individual User Names on the right-hand side.  If the system is blank to begin with, you can easily 
define your own sets by clicking on the New Group button and the New User button on the toolbar, 
as shown in Figure 8.2, and then assign users to groups by clicking on the Associate Users With 
Groups button. 

 
Figure 8.2. 'New User,' 'New Group,' and 'Associate Users With Groups' Toolbar Buttons 

 
Figure 8.3 shows three groups: GENERAL MANAGER, OPERATORS, and SUPERVISORS.  Their 
folders have been expanded (click on the + symbol next to the folder, or double-click on the name) 
to show which users are assigned to them.   
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Figure 8.3. User Names and Groups 

Double-click on a group name to edit its parameters.  Similarly, double-click on a name to edit that 
user's security parameters. 

Security Configuration Modes 
The Security Server supports three general modes of security configuration. The security mode is 
specified in the Security Configurator: 
• Basic security mode 
• Advanced security mode 
• Integrated NT security mode 
The Security Server can run in “basic” mode or “advanced” mode. Basic mode is suggested for first 
time users of the Security Server.  The advanced mode is equivalent to the only security mode in 
previous versions of ProcessView. 
Note: You can always convert a basic mode configuration to an advanced mode configuration at 
any time. However, the conversion from basic mode to advanced mode cannot be reversed (i.e. an 
advanced configuration cannot be converted to a basic configuration). 
The integrated NT security mode automatically synchronizes users and groups with the Windows NT 
security database. The node on which the Security Server runs must have Windows NT, Windows 
2000, Windows XP, or .NET Server, but the client nodes can run on any Windows operating system 
(i.e. Windows 95, Windows 98, Windows Me, etc.). 
For more information about security modes, please see the Security Server Help documentation on 
the ProcessView CD. 

Assigning Application Actions 
To restrict which users and/or groups can use various features within the ProcessView client 
applications (e.g., GraphWorX and TrendWorX, etc.), select the menu Application Actions from 
the Edit menu, as shown in Figure 8.4.   

 
Figure 8.4. Application Actions 
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The Actions/Users Association window appears, as shown in Figure 8.5.   

 
Figure 8.5. Assigning Application Actions 

The available application actions are listed on the left, and the users and groups defined in the 
system are on the right.  Expand an application (by either clicking on the + symbol or double-clicking 
on the name).  To associate a user and/or group with a specific action: 
Select an action. 
Select a user or group. 
Click on the <<Move>> button. 
The User or Group name then appears under that action.  As a cross-reference, the action also 
appears on the right under the User or Group name.  Continue this process for each action desired.   
To remove a user or group from a particular action, simply click on the User/Group name and press 
the keyboard DEL key. 
If all but a few actions are desired for a particular user or group (e.g., they can do everything but Exit 
Application and Exit Runtime), then instead of adding the desired actions one at a time, select an 
entire application and press <<Move>>.   All of the sub-actions are moved all at once under that 
User/Group name on the right.  Then simply delete those unwanted actions by selecting them and 
pressing DEL. 
When nobody is logged into the system, the Security Server uses the configuration defined for the 
Default group (advanced security mode only).  A new installation has DEFAULT appear under all 
the action items (so that, by default, you can use everything in the system while the project is being 
developed).  To remove the DEFAULT user from a particular action, press the keyboard DEL key as 
explained above. 
To further define the parameters associated with the Default group, such as I/O Point write 
restrictions, file access, account policies, etc., select Default Group from the Edit menu. 

ProcessView Tray Utility 
The ProcViewTray Utility provides a way either to manually or automatically start and/or stop each of 
the components within ProcessView. This handy utility (ProcViewTray.exe located in the Program 
Files\Smar\ProcessView\Bin directory) should be placed in the computer's Startup group, so that it 
is available every time the computer is started.  It is represented as a triangle icon in the Windows 
System Tray in the lower right corner of the Task bar, as shown in Figure 8.6.   
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Figure 8.6. ProcessView Tray 

The top section lists the various components of ProcessView.  Selecting one shows any sub-
components in a pop-up menu.  For each item there is a list of commands to Start/Stop and Auto 
Start/Auto Stop the application.   
The Auto Start and Auto Stop options permit a ProcessView system to be brought up and shut 
down in an orderly fashion. Selecting these items puts the application in a management list.  To 
access this list and make additional changes to the optional parameters, click on the ProcessView 
Tray icon and select the Configure menu item. The following window appears as shown in Figure 
8.7.   

 
Figure 8.7. ProcessView Tray Configuration 

Any items already selected for Auto Start/Auto Stop already appear in the respective lists.  To add 
further to these lists, select the desired application from the drop-down list and check the Include in 
Auto Start/Stop List, entering a delay if desired. Use the Up/Down arrow keys to change the 
sequence of the list. 
In the Optional Startup Command field, you can specify a startup file for the selected application. 
For example, you may want to start GraphWorX with a specific display (.gdf) file in runtime mode. To 
select a startup file, click the ... button to the right and browse for the file. Select a file and then click 
OK. The directory path and file name appear in the Optional Startup Command field, as shown in 
the figure below. 
For complete information about configuring ProcessView Tray, please see the ProcessView Tray 
Help documentation. 
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GenBroker 
ProcessView provides a utility called “GenBroker” to assist with projects using a set of applications 
networked together. There are many options and configurations possible. As with other chapters in 
this ”Getting Started” manual, this section covers just some basics to get a project pointed in the 
right direction.  For further information, please see the GenBroker Help documentation on the 
ProcessView product CD. 

Starting the GenBroker Configurator 
To configure GenBroker, choose Start > Programs > Smar ProcessView > Tools > GenBroker 
Configurator. 
GenBroker permits you to designate which method to use for network communications as well as 
define remote servers for a networked set of workstations. 

Selecting a Communications Subsystem 
The first step is to choose which communication subsystem to use, GenBroker or OPC, in the Client 
tab of the Properties dialog box, as shown in Figure 8.8.   

 
Figure 8.8. Choosing the Communication Method 

OPC Communications uses standard, fast COM and DCOM communications technology designed 
for local networks. 
GenBroker is a communication method that enables OPC communications over the Internet and 
has new features exploited primarily by WebHMI and DataWorX.  
Select the desired method and click OK. 
If OPC Communications is selected, nothing more needs to be configured.   
If GenBroker Communications is selected, you should click the New button and create a 
GenBroker configuration file to set up the GenClient/GenBroker communications. For complete 
information about configuring GenBroker, please see the GenBroker Configurator Help 
documentation. 
Note: You must set GenBroker active on the server node using the ProcessView Tray in 
ProcessView. For complete information about configuring GenBroker, please see the GenBroker 
Configurator Help documentation on the ProcessView CD.  

GenBroker Channels 
There are three basic methods for GenBroker Networked communications: 
OPC Direct – In an OPC direct channel, the client applications, such as GraphWorX, TrendWorX, 
and AlarmWorX, communicate directly with OPC servers. This method uses standard fast DCOM 
over an intranet or local area network (LAN), but does not allow you to set a connection retry period 
or timeout settings. This method of communication is similar to that of OLExpress. 
Using a Direct Channel – In a direct channel, client applications communicate with GenBroker 
software located on remote nodes on an intranet or LAN. This method allows you to set a 
connection retry period and timeout settings. GenBroker then communicates (locally) with the target 
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OPC servers on behalf of the client application. There are predefined direct channels that users 
cannot delete.  
Using a Channel via a mediator node (Indirect Channel) – The client applications communicate 
with a mediator node. The mediator does not communicate with any specific OPC server, but rather 
redirects the communication to another node, where the GenBroker is located. The client 
applications may not have any direct connection with the node where the GenBroker they use is 
located. Users may create and delete these indirect channels. By default, there are none of these 
mediator nodes defined in a new configuration file. 
The channels, either direct or indirect, translate the OPC COM calls into one of several protocols 
(described in the next section).  The translated calls then traverse over the network to the remote 
node. The awaiting GenBroker on the remote station then translates the calls back into OPC COM, 
where the local OPC server can then execute them. 
Think of GenBroker as a universal translator, taking OPC communications and transforming them 
into various protocols for network transmission. 

GenBroker Protocols 
GenBroker uses the following basic methods of networked communications: 
• OPC direct channel  
• Direct channel over DCOM 
• Direct channel over TCP/IP 
• Direct channel over SOAP/XML 
• Indirect channel via a mediator node  
Most channels, either direct or indirect, translate the OPC COM calls into one of two protocols and 
transmit them to the remote node, where GenBroker can execute them. (The OPC Direct channel is 
the only exception; it uses OPC calls.) Protocols that every channel can use for these transmissions 
are: 
• DCOM: Suitable for local networks enabled with DCOM.  Not recommended for Internet use. 
• TCP/IP: Communicates over intranet/Internet through routers and firewalls. 
• SOAP/XML: Communicates over intranet/Internet through routers and firewalls. 
Note: In order to use SOAP/XML channels, you must you must first install Microsoft® Internet 
Information Server (IIS) on the GenBroker Server node. 

TraceWorX 
Using a technology that has been incorporated into all Smar products, TraceWorX provides online 
diagnostics and tuning of applications running in the ProcessView system. TraceWorX is designed 
expressly for systems integrators, OEMs and customers who want to have tools for doing their own 
troubleshooting and diagnostics. To configure TraceWorX, choose Start > Programs > Smar 
ProcessView > Tools > TraceWorX. 
TraceWorX tracks the runtime activity for each ProcessView application and logs the runtime data to 
a log file based on user-configured trace levels. The log file provides a thorough, color-coded report 
detailing all activity for the application, including the time, the date, the severity level, and a 
description of the event or problem.  
TraceWorX also features several options for reporting issues to technical support. If you are 
experiencing problems with any applications, the log file deployment options, such as compressing 
and e-mailing log files, are ideal for tracking and archiving data and sending detailed reports to 
technical support. Developers can use these reports to identify the source of the problems. 
For complete information about using TraceWorX, please see the TraceWorX Help documentation 
on the ProcessView product CD.  

ProjectWorX 
ProcessView contains numerous applications with multiple components, requiring a well-trained user 
in order to successfully create, integrate, deploy, and manage projects. Each of these components 
requires complex setup of many different types of configuration files, databases, and OPC servers, 
as well as runtime and security settings. To simplify the management and deployment, Smar has 
introduced ProjectWorX, which integrates all ProcessView applications into a single, easy-to-
manage format. For more information, please see the ProjectWorX Help documentation on the 
ProcessView product CD. 
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Tips and Tricks 
Introduction 

This chapter provides various tips and tricks for using ProcessView on a project. 

Project Management 
Using ProjectWorX 
ProcessView contains numerous applications with multiple components, requiring a well-trained 
user in order to successfully create, integrate, deploy, and manage projects. Each of these 
components requires complex setup of many different types of configuration files, databases, and 
OPC servers, as well as runtime and security settings. To simplify the management and deployment 
of the broad spectrum of ProcessView applications, Smar has introduced ProjectWorX, a sort of 
"super configurator" that integrates all ProcessView applications into a single, easy-to-manage 
format. The ProjectWorX user interface is basically a container embedded in the Microsoft 
Management Console (MMC). The ProjectWorX console conveniently consolidates all of your 
PROCESSVIEW files in one easily accessible location, enabling you to: 
• Organize all ProcessView application files into separate projects. 
• Create new ProcessView application files and OPC server configurations. 
• Import application files into projects. 
• Start and stop ProcessView applications. 
• Pack project files into a single, compressed file, and unpack project files for easy deployment to 

multiple computers.  
• Activate entire projects into runtime mode. 
• Control the layout of windows using the Screen Manager. 
• Configure security settings to password-protect projects. 
• Back up project files to Microsoft Visual SourceSafe. 
• Search for and replace machine names and OPC tags throughout all project files using a global 

find/replace utility. 
• Publish projects to the Web. 
• Control and monitor runtime functions for all applications using ProcViewTray. 
• Launch ProcessView system tools. 
• Generate comprehensive reports for all files and projects. 
For additional information about ProjectWorX, please see the Help documentation for this 
application. 
To launch ProjectWorX: 
1. From the Windows Start menu, select Programs > Smar ProcessView> ProjectWorX. 
2. The first time you open ProjectWorX, you are asked to select a folder in which the ProjectWorX 

database will be stored, as shown in Figure 9.1. Browse for a projects folder, and then click 
OK. 

 
Figure 9.1. Main Projects Folder Selection 
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3. The Smar ProjectWorX Projects console opens in the Microsoft Management Console, as 
shown in Figure 9.2. This is the main ProjectWorX console that allows you manage your 
ProcessView projects. This is a split window with a tree control view in the left-hand pane and a 
configuration view in the right-hand pane.  

4. Select Help Topics from the Help menu for information about setting up your projects. 

 
Figure 9.2. ProjectWorX Console  

File Names 
Do not use full path names for file references.  For example, in the GraphWorX Display Load action, 
use "MyDisplay.gdf" instead of "C:\ProgramFiles\Smar\ProcessView\MyProject\MyDisplay.gdf." This 
way, when the project is used on another machine, it does not have to be in the exact same 
directory. 

Specifying a Working Directory 
Use the Set Working Directory feature to establish a common location for file storage.  When 
working with a group of developers, have everyone point to a common location on the network, 
making updates easier.  
Selecting Set Working Directory from the Tools menu opens the Set Working Directory dialog 
box, shown in Figure 9.1, which enables you to configure a custom directory in which all application 
configuration files will be stored and retrieved. Click Browse to select the directory.  

 
Figure 9.3. Set Working Directory Dialog Box 
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Aliases 
If tag names are not yet defined in the OPC server, use aliases with descriptive names.  They can 
be tied to simulated points for testing purposes and then easily switched to live I/O after tags are 
defined. 
Use aliases for connections in symbols added to a symbol library.  With long descriptive names for 
the aliases, it becomes a self-documenting library.  For example, it is far more understandable 
having a connection with the name <<OutsideAirTemperatureAnalogValue>> than it is to have an 
old OPC connection like "SMAR.Modbus\PLC12.T101." 
For information about configuring aliases, please see the GraphWorX Help documentation. 

GraphWorX 
Use the Shared Object Name property for objects that will be used in more than one place on more 
than one GraphWorX display. That way, they can be globally updated should changes be required. 
Use the Object Name property for every object.  This makes it easier to identify the objects in 
Search/Replace reports, Alias lists, Find reports, and so on. 
To share just one object with someone else, simply drag it out of the GraphWorX display directly to 
the desktop of your computer.  It creates a "scrap" file, which can be shipped over the network 
and/or copied to a floppy disk, etc.  This scrap file can then simply be dragged back into another 
GraphWorX display. 
To duplicate and place objects in one step, hold down the CTRL key as you drag them. 
Open up multiple instances of GraphWorX to copy objects between different displays. 
Instead of using two separate Hide dynamics to toggle the visibility of two different objects, first 
select the two objects and then apply the Digital Selector dynamic.  For more information, please 
refer to the Gen32Demo tutorial section in Chapter 4. 
For process points, use a sunken 3D Edge and a fill color: white, if it permits data entry; gray if it is 
read-only.   That way, operators will know visually whether a field has read/write access. 
To quickly give objects a similar look and feel (i.e., fill color, gradient, line style, etc.) simply copy the 
"master" object and then right-click on another object and choose Paste Visible Properties from 
the pop-up menu. This duplicates the object and its properties in the display. 
Use Templates to facilitate a common look and feel across an entire set of displays.  Then to update 
the entire project, only the template needs to be updated. 

TrendWorX 
Use the Load/Save Configuration file to easily transfer Trend Viewer ActiveX setup parameters 
between different displays. 
When plotting a digital point, use the Stair Plot option for the pen. An example of this is shown in 
the Gen32Demo file “Trend_TimePlot.gdf.” 
If only a few of the options in the Trend Viewer toolbar need to be accessed by the operator during 
runtime, consider using buttons tied to VBA scripts. 
In the Trend Logger, if you desire more then one statistical filter for the logged data, use the Edit > 
Multiply menu option on the tag.  Then, for each of the duplicated tags, select a different filter.  An 
alternative is to log all samples to disk and use different filters from within the Trend Report 
package. 
To avoid logging unnecessary small changes in an analog value, use an appropriate Deadband 
setting, using either a percentage change or an absolute value change as the criteria for logging a 
new sample to disk. 
To optimize writing the data to the database, be sure to properly set up the Logging parameters for 
each logging group.  For example, set On Interval to 5 minutes; TrendWorX will then collect data at 
the sample rate, but log only after five minutes’ worth of information has been gathered. 
When using the Trend Viewer ActiveX with live data, trends will start over whenever the display is 
first called up.  If you wish to have the trend windows with data already populated, do not subscribe 
to OPC tags directly.  Rather, set up Persistent Trending and connect your pens to these items. 
Explore the VBA methods and properties exposed by TrendWorX as well as the SQL Tool ActiveX 
provided for custom applications. 
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AlarmWorX 
Be sure to type in helpful text in the Help Instructions field when configuring an alarm tag.  This 
information can then be configured to pop up automatically in the ToolTips in the AlarmWorX Viewer 
ActiveX. Immediate access to this information will aid operators in resolving or acknowledging the 
alarm condition. 
Categorize your alarms into different alarm areas and sub-areas.  By grouping alarms in this way, it 
is possible to take advantage of several advanced features offered by AlarmWorX, such as: 
• Acknowledging all the alarms within a given area. 
• Linking a dynamic in GraphWorX to the alarm status bit of an area (e.g., flash a picture 

of an alarm horn whenever any alarm within the area is active). 
• Viewing only the alarms in the Live Alarm Viewer ActiveX from a given area. 
By default, the Alarm Viewer ActiveX is sorted by the Active Time of the alarms.  Therefore, 
acknowledging an alarm does not change the sort order.  If you wish to have acknowledged alarms 
float to the top of the list, sort by the Event Time column instead. 
The alarm historical report ActiveX can be linked to five of your own Crystal Report templates, 
allowing the reports to be tailored to fit your needs.  These are set up in the Reporting tab of the 
Report ActiveX Properties dialog box. 
Consider using a different size font and even a different color scheme for alarms that are of higher 
priority.  This way, they will jump out of the list and get your attention.  These are set up in the Row 
tab of the Alarm Viewer ActiveX Properties dialog box. 
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Help and Technical Support  
Contact Information  

Smar 
E-mail: smarinfo@smar.com 
Web: www.smar.com 
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Error Messages 
This chapter provides a list of possible causes and solutions for system problems you may 
encounter while using ProcessView Software. 
If the information provided here does not solve your problem and you have installed the system 
according to the “Getting Started Reference Guide” procedures, contact Smar Technical Support. 
Please refer to Chapter 11 in this “Getting Started” manual for more information on Technical 
Support. 

ProcessView Installation Errors 
Smar About Box Automation Server is not registered! - The installation of ProcessView failed to 
register the About Box Automation Server. Restart your computer and try the installation again. If the 
problem persists, contact SMAR Technical Support. 
Smar Tag Browser Automation DLL not registered! - The installation of ProcessVIew failed to 
register the Tag Browser Automation Server. Restart your computer and try the installation again. If 
the problem persists, contact Smar Technical Support. 

Expression Errors 
Syntax Error: Unknown number format. 
A number was specified in the expression, but in an invalid or unknown format. 
Syntax Error: No end tag token. 
A start tag token ({{) was found, but no matching end tag token (}}). 
Syntax Error: No end local variable token. 
A start local variable token (~~) was found, but no matching end local variable token (~~). 
Syntax Error: Unknown function. 
An unknown function name was specified in the expression. 
Syntax Error: Unknown operator. 
An unknown operator was specified in the expression. 
Syntax Error: No tag name. 
Start and end tag tokens were found with no tag name specified between the tokens. 
Syntax Error: No local variable name. 
Start and end local variable tokens were found with no local variable name specified between the 
tokens. 
Syntax Error: Missing left parenthesis. 
A right parenthesis was found with no matching left parenthesis. 
Syntax Error: Missing right parenthesis. 
A left parenthesis was found with no matching right parenthesis. 
Syntax Error: Incorrect number of parameters. 
The wrong number of parameters was specified in a function used in the expression. 
Syntax Error: Unexpected token. 
An unspecified syntax error exists in the expression. 
Syntax Error: No end string constant token. 
A start string constant token ($”) was found, but no matching end string constant token (“$). 
Syntax Error: No end alias token. 
A start alias token (<<) was found, but no matching end alias token (>>). 
Syntax Error: Old shift operator unsupported. See shl() and shr(). 
Old Shift operators (<< and >>) are no longer supported for expression configuration.  Use shl() and 
shr() functions instead. 



Error Messages 

 

11.2 

Language Support 
The selected language resource does not have the appropriate version number.  Please 
obtain an updated version of the file: <FileName> 
The selected language translation is not available. -This error message appears when you 
attempt to change to a language for which there is no available language resource file. 

GraphWorX 
Unexpected file format. - This error occurs if the format of the file you are attempting to open is not 
valid for this version of GraphWorX.  This message will appear if you attempt to open a file that is 
not a GraphWorX display file.  This message will also appear if you attempt to open a display file 
created in a newer version of GraphWorX than the version currently being used to open the file.  For 
instance, using GraphWorX v5.2, you cannot open displays files created with GraphWorX v6.0 (the 
newer format cannot be understood by the older GraphWorX).  However, you can open v5.2 
displays in GraphWorX v6.0 (all old displays will run in newer versions of GraphWorX). 
Failed to open document. - This generic error message appears when a GraphWorX display fails 
to load.  Reasons for the failure vary, depending on the situation.  One possible cause is that the 
GraphWorX display contains ActiveX controls that are not properly registered.  
Failed to save document. - This error occurs when you try to save a read-only file. 
Failed to create empty document. - This error typically occurs when GraphWorX is unable to start 
up properly.  This can occur when certain Windows resources are low or have run out. 
Failed to create object.  Make sure the object has been entered into the system registry. - 
This error can occur when you attempt to insert an ActiveX control that has not been properly 
registered. 
The selected language resource does not have the appropriate version number.  Please 
obtain an updated version of the file: <Filename> - This error message appears when you try to 
change GraphWorX’s language if the version number of GraphWorX and that of the language 
resource file for the selected language do not match.  These version numbers must exactly match to 
load the language successfully.  You can check the version number of GraphWorX by opening the 
About box and the version number of the language resource file by right-clicking on the file in 
Windows Explorer and choosing the Properties option from the pop-up menu. 
The selected language translation is not available. - This error message appears when you 
attempt to change GraphWorX to a language for which there is no available language resource file. 
License Failure. - This message occurs if GraphWorX is unable to connect to the SMAR licensing 
server.  This can occur if the licensing server (GenRegistrarServer.EXE) is not properly registered. 
Insufficient Security Level - This message appears in Runtime mode when the user currently 
logged into the SMAR security system does not have permission to perform the command that has 
just failed.  This message can also occur if GraphWorX is unable to connect to the SMAR Security 
Server. 

TrendWorX 
Security Server Timed Out! - Both TWXViewer and TWXBgTrend display a dialog box saying this. 
You are running the software in Demo mode or a Time Limited mode (e.g., Temporary License 
mode). Install a proper license.  
No protection key has been found or the demo period has expired. - A message that appears in 
TWX Viewer. You are running the software in Demo mode or a Time Limited mode (e.g.,  
Temporary License mode). Install a proper license.  

Trend Viewer ActiveX 
Insufficient Security Level! - It appears when you attempt to perform an operation within the 
ActiveX Control without having the required security attributes in the ProcessView Security Server. 
The selected language translation is not available. - It appears when you try to switch languages, 
and the ActiveX Control does not find the required language resource DLL . 
Please Enter A Valid Range Value! - It appears when you try to enter an invalid High or Low 
Range value or string on editing range information. 
A search string must be specified - It appears when you try to perform point replacement 
operations without specifying a search string. 
A replace string must be specified - It appears when you try to perform point replacement 
operations without specifying a replace string. 
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Error in Saving Info... - It appears when an error occurs while you try to save to a file statistical 
information from the signals displayed in the Trend ActiveX 
Cannot switch trend mode. Modify Connections First! - It appears when the Trend ActiveX has 
been configured for a History Only replay in Freeze mode and you try to connect real-time pens or, 
if real time pens exist, you try to select Frozen Historical replay. 
Please Enter A Valid Alarm Value! - It appears when you try to enter an invalid High or Low 
Alarm value on editing pen alarm  information. 
Please Enter A Valid Point Name - It appears when you try to edit a pen configuration and there is 
no point (signal) name entered for the pen. 
Please Enter A Valid Description Text - It appears when you try to edit a pen configuration and no 
description text has been entered for the pen. 
Failed to Create Toolbar! - It appears when the Trend ActiveX fails to create its floating toolbar 
upon entering Runtime mode 
Failed to Create CMiniFrameWnd! - It appears when the Trend ActiveX fails to create its miniframe 
window required for its floating toolbar upon entering Runtime mode. 
Cannot delete XY Plot X-axis in Animate mode - It appears when you try to delete a pen 
designated as the X-axis pen in an XY-Plot. 
Error opening Tag Browser - It appears when the Trend ActiveX cannot load the Smar Tag 
Browser. Make sure that the Tag Browser has been properly installed and registered. 
Error Opening About Box - It appears when the Trend ActiveX cannot display the About box 
information. Make sure that the SmarAbout.dll has been properly installed and registered. 

Persistent Trending 
No Group Name Selected! - It appears when you try to add or edit a Persistent Trending group and 
have not specified a name for it. 
Failed to add DOC to ROT - It appears when Persistent Trending cannot register with ROT 
(Running Object Table) upon initialization.  If this error occurs, you are advised to exit Persistent 
Trending and reboot the PC. 
Failed to remove DOC from ROT - It appears when Persistent Trending cannot unregister from 
ROT (Running Object Table) upon exiting.  If this error occurs, you are advised to exit Persistent 
Trending and reboot the PC. 
Error opening Tag Browser - It appears when the Persistent Trending cannot load the Smar Tag 
Browser. Make sure that the Tag Browser has been properly installed and registered. 
Error Opening About Box - It appears when the Persistent Trending cannot display the About box 
information. Make sure that the SmarAbout.dll has been properly installed and registered. 
Logging time interval should be adjusted or the number of samples increased.  Data buffer 
can be refreshed prior to logging. - This appears when you configure a Persistent Trending group 
for logging to a text file, and the Log to Disk settings are such that the logging interval is larger than 
the amount of data (samples) the group has been configured to keep in memory buffers. As a result, 
you can lose data while logging. 
Insufficient Security Level! - It appears when you attempt to perform an operation within the 
Persistent Trending without having the required security attributes in the ProcessView Security 
Server. 
The selected language translation is not available. - It appears when you try to switch languages 
and the Persistent Trending cannot find required the language resource DLL. 
A search string must be specified - It appears when you try to perform point replacement 
operations without specifying a search string. 
A replace string must be specified - It appears when you try to perform point replacement 
operations without specifying a replace string 
OLE initialization failed.  Make sure that the OLE libraries are the correct version. - It appears 
upon startup if the system OLE libraries have not been properly installed or are not up to date. 



Error Messages 

 

11.4 

TrendWorX Container 
Error Opening About Box - It appears when the TrendWorX Container cannot display the About 
box information. Make sure that the SmarAbout.dll has been properly installed and registered. 
OLE initialization failed.  Make sure that the OLE libraries are the correct version. - It appears 
upon startup if the system OLE libraries have not been properly installed or are not up to date. 
Insufficient Security Level! - It appears when you attempt to perform an operation within the 
TrendWorX Container without having the required security attributes in the ProcessView Security 
Server. 
The selected language translation is not available. - It appears when you try to switch languages 
and the TrendWorX Container does not find the required language resource DLL . 
Failed to create object.  Make sure the object has been entered into the system registry. - It 
appears when you try to insert an ActiveX Control which cannot be found or has not been properly 
registered in the system registry. It is suggested that you re-install the specific control. 
Could not save display list - It appears when you try to save a display file list for automatic loading 
by TrendWorX Container. Make sure that the target directory exists. 
Could not load display list - It appears when you try to load a display file list for automatic loading 
by TrendWorX Container. Make sure that the target directory exists. 
A Window with a titlebar must have a border. - It appears when you configure a display or main 
application window style with conflicting options. 
This is NOT a Pocket TrendWorX File. Please Exit CE Configuration Mode First. - It appears 
when the TrendWorX Container has been set in CE Configuration mode and you try to load a non-
CE display file. 
Cut to clipboard failed. - It appears when the TrendWorX Container fails to execute a Cut menu 
action on an ActiveX Control.  
Copy to clipboard failed. - It appears when the TrendWorX Container fails to execute a Copy 
menu action on an ActiveX Control. Retry the operation 
Failed to paste object from clipboard. - It appears when the TrendWorX Container fails to execute 
a Paste menu action from the Windows Clipboard. Retry the operation choosing Paste Special. 
Item on the clipboard has zero size - It appears when the available item on the Windows 
Clipboard has zero size. Retry placing the item on the Clipboard again. 

TrendWorX Reporting 
Error Opening About Box - It appears when the TrendWorX Reporting cannot display the About 
box information. Make sure that the SmarAbout.dll has been properly installed and registered. 
OLE initialization failed.  Make sure that the OLE libraries are the correct version. - It appears 
upon startup if the system OLE libraries have not been properly installed or are not up to date. 
Insufficient Security Level! - It appears when you attempt to perform an operation within the 
TrendWorX Reporting without having the required security attributes in the ProcessView Security 
Server. 
The selected language translation is not available. - It appears when you try to switch languages 
and the TrendWorX Reporting does not find the required language resource DLL . 
Error opening Tag Browser - It appears when the TrendWorX Reporting cannot load the Smar 
Tag Browser. Make sure that the Tag Browser has been properly installed and registered. 
Failed to add DOC to ROT - It appears when TrendWorX Reporting cannot register with ROT 
(Running Object Table) upon initialization. If this error occurs, you are advised to exit TrendWorX 
Reporting and reboot the PC. 
Failed to remove DOC from ROT - It appears when TrendWorX Reporting cannot unregister from 
ROT (Running Object Table) upon exiting. If this error occurs, you  are advised to exit TrendWorX 
Reporting and reboot the PC. 
Please do not select to retrieve qualities or limit the number or report tags. - It appears during 
the configuring or editing of a report, which returns the samples in a CSV-type of format. There are 
more than 55 configured tags for the report, and you select Retrieve Qualities, as well.  This would 
result in a report with more than 255 columns, an upper limit for reporting to Excel, etc. You should 
either reduce the number of configured tags or not select Sample Quality Retrieval for the report. 
No Report Name Assigned - It appears during the configuring or editing of a report, to which no 
Report Name has been assigned. You should enter a Report Name. 
No Tags Selected in Report - It appears during the configuring or editing of a report, for which no 
tags have been selected. You should select tags for the report. 
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No Source Database Selected - It appears during the configuring or editing of a report, for which 
no source database connection has been established. You should establish a source database 
connection for the report. 
No Target Database Selected - It appears during the configuring or editing of a report to a 
database and no target database connection has been established for the report. You should 
establish a target database connection for the report. 
No Source Database Object Selected - It appears during the configuring or editing of a report, for 
which no source database group has been selected. You should establish a source database group 
for the report. 
No Source Group Object Selected - It appears during the configuring or editing of a report, for 
which no source logging group has been selected. You should establish a source logging group for 
the report. 
No Condition Selected - It appears during the configuring or editing of a report that executes on a 
condition, but no condition has been specified. You should configure a condition for the report. 
Database query failed - It appears during the configuring or editing of a report's database group 
object, logging group, or tags. TrendWorX Reporting was unable to get the information from the 
underlying historical database.  Make sure that the database has not been moved or not been 
opened in Exclusive mode. If it is a remote database, make sure security has been properly 
configured and rights to reading info from the database have been enabled.  In addition, make sure 
that none of the historical database info tables has been deleted. You may want to reload the 
configuration to the datalogger again, and then attempt to configure the report. 
Database Connection Failed - It appears during the configuring or editing of a report's database 
group object, logging group, or tags. TrendWorX Reporting was unable the get the information from 
the underlying historical database.  Make sure that the database has not been moved or not been 
opened in Exclusive mode. If it is a remote database, make sure security has been properly 
configured and rights to reading info from the database have been enabled.  In addition, make sure 
that none of the historical database info tables has been deleted. You may want to reload the 
configuration to the datalogger again and then attempt to configure the report. 
No Table Entries Found! - It appears during the configuring or editing of a report's database group 
object, logging group or tags. TrendWorX Reporting did not find any records on the associated 
tables. You must either correctly configure data logging and download the configuration to the 
TrendWorX SQL Logger or try to download the configuration to the datalogger again and then 
attempt to configure the report. 
This database type is NOT Supported! - It appears during the configuring or editing of a report's 
source or target database connections and the underlying database type is not supported. 
TrendWorX for version 6.0, supports ONLY MS Access, MS SQL Server, MSDE and Oracle. 
Please Enter a Valid Row Number (1 to 25000) - It appears during the configuring of a report to 
MS EXCEL and you select a starting Row for the report outside the limits supported by MS EXCEL. 
Please Enter a Valid Column Number (1 to 255) - It appears during the configuring of a report to 
MS EXCEL, and you select a starting Column for the report outside the limits supported by MS 
EXCEL. 
Maximum Number of Configured Reports has been Reached! - It appears when TrendWorX 
Reporting reaches its maximum number of configured reports. 
Report Cannot be Disabled.  Try Canceling the Report. - It appears when you try to disable a 
report in Runtime mode while the report is executing. You should first cancel the report and then 
disable it. 
Please Select a Valid Report Time Span - It appears when you configure a report with an invalid 
time range span. You should adjust this selection. 
Please make a valid time range selection.  Report End Time is earlier than Report Start Time. 
- It appears when you configure a report to execute within a starting time and an ending time and the 
report end time is newer than the report start time. 
No Target Text File is Selected -It appears when you configure a text type of a report to execute 
and no valid target filename has been specified. 
No Valid Excel Worksheet is Selected - It appears when you configure an EXCEL-type of a report 
to execute and no valid EXCEL Worksheet name has been specified. 
In addition to the above user interface error messages, TrendWorX Reporting sends the following 
messages and errors to the Gen Registrar (and if desired to the NT Event Logger). 
Started Reports (Severity 500) - When entering Runtime mode. 
Stopped Reports (Severity 500) - When exiting Runtime mode. 
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Error in Starting Reports (Severity 800) - TrendWorX Reporting could not enter Runtime mode.  
Make sure that the computer is not running out of memory or resources or running some extremely 
CPU-intensive application. 
Report was deleted (Severity 650) - A report was deleted while TrendWorX Reporting was in 
Runtime mode. 
Report was Cancelled (Severity 650) - A report was cancelled while TrendWorX Reporting was in 
Runtime mode. 
Report was deleted (Severity 650) - A report was deleted while TrendWorX Reporting was in 
Runtime mode. 
No Errors Found (Severity 500) – The report was executed with no errors. 
Invalid Table Name (Severity 650) - The report failed to execute because TrendWorX Reporting 
could not get the information from the underlying historical database.  Make sure that the database 
has not been opened in Exclusive mode or moved. If it is a remote database, make sure that 
security has been properly configured and rights to reading info from the database have been 
enabled. Also make sure that no historical database info tables have been deleted. You may want to 
reload the configuration to the datalogger again and then attempt to configure the report. 
No Data Found (Severity 650) - The report failed to execute because TrendWorX Reporting could 
find no historical data tables in the source database.  
Target Connection Failed (Severity 650) - The report failed to execute because TrendWorX 
Reporting could establish no database connection to the target database.  Make sure that the target 
database connections has been properly configured and not deleted, and all passwords and user id 
accounts have not been modified since the configuration of the report. 
Failed to Create Target Table (Severity 650) - The report failed to 
execute because TrendWorX Reporting could not create the target table either in the source or the 
target database. TrendWorX Reporting will try to create a target table in the source database even if 
the report is configured as a CSV or MS EXCEL report type to accelerate the report creation.  Make 
sure that the source and target database connections have been properly configured and not 
deleted; the hard disk where the database is located has enough disk space; and the report target 
name does not include characters such as *, ^ etc. Also make sure that the tags configured in the 
report do not have characters such as *,%, etc. in their names. You may have to edit the Logging 
Names in the TrendWorX configurator for the tags being logged. 
Failed to Open Source Connection (Severity 650) - The report failed to execute because 
TrendWorX Reporting could not establish a source database connection.  Make sure that the source 
and/or target database connections have been properly configured and not deleted, and all 
passwords and user id accounts have not been modified since the configuration of the report. 
Failed to Create ADO Objects (Severity 650) - The report failed to execute because TrendWorX 
Reporting could not create ADO (ActiveX Data Objects) required to execute the reports.  Make sure 
that ADO has been properly installed. Try re-installing ADO from the Smar CD.  
Error in Updating Target Table (Severity 650) - The report failed to execute because TrendWorX 
Reporting could not update the target table either in the source or the target database. TrendWorX 
Reporting will try to create a target table in the source database even if the report has been 
configured as a CSV or a MS EXCEL report type to accelerate the report creation.  Make sure that 
the source and target database connections have been properly configured and not deleted; the 
hard disk where the database is located has enough disk space; and the report target name does 
not include characters such as *, ^, etc. In addition, make sure that the tags configured in the report 
do not have characters such as *,%, etc. in their names. You may have to edit the Logging Names in 
the TrendWorX Configurator for the tags being logged. 
Error in Opening Target Table  (Severity 650) - The report failed to execute because TrendWorX 
Reporting could not read (open) the target table either in the source or the target database. 
TrendWorX Reporting will try to create a target table in the source database even if the report is 
configured as a CSV or a MS EXCEL report type to accelerate the report creation.  Make sure that 
the source and target database connections have been properly configured and not deleted; the 
hard disk where the database is located has enough disk space; and all passwords and user id 
accounts have not been modified since the configuration of the report. 
Failed to Load EXCEL  (Severity 650) - The report failed to execute because TrendWorX 
Reporting could not load EXCEL.  Make sure that MS EXCEL has been properly installed on the 
same PC where TrendWorX Reporting is installed and that the desired MS EXCEL workbook has 
not been opened exclusively or deleted. 
Error in Printing EXCEL Worksheet  (Severity 650) - The report failed to print automatically the 
target MS EXCEL Worksheet.  Make sure there a printer has been installed and configured properly. 
Error in Disconnecting From EXCEL (Severity 650) - TrendWorX Reporting failed to disconnect 
from MS EXCEL.  The user may have to shutdown MS EXCEL manually. 
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TWXTray 
TWX SQL Data Logger failed loading its latest configuration. -This error occurs when TWX SQL 
Data Logger cannot load its last configuration. The likeliest cause of this error is that no TWX SQL 
Data Logger configuration exists. Use TrendWorX Configurator to create and save Logger 
configuration. 
Unable to start an instance of TWX SQL Data Logger. - COM error occurred when creating TWX 
SQL Data Logger object. Make sure that TWX SQL Data Logger application has been properly 
installed and registered. 
Can not start TWXReporter. - This message indicates an error has occurred during an attempt to 
start TrendWorX Reporting. Make sure that TrendWorX Reporting application has been properly 
installed and registered. 
'EnterRuntime' method of TWX Reporter failed. - This message indicates an error has occurred 
during an attempt to call TrendWorX Reporting's EnterRuntime method. Make sure that TrendWorX 
Reporting application has been properly installed and registered. 
'Open' method of TWX Reporter failed. - This message indicates an error has occurred during an 
attempt to call TrendWorX Reporting's Open method. Make sure that TrendWorX Reporting 
application has been properly installed and registered. 
'StopReports' method of TWX Reporter failed. - This message indicates an error has occurred 
during an attempt to call TrendWorX Reporting's StopReports method. Make sure that TrendWorX 
Reporting application has been properly installed and registered. 
'Open' method of Persistent Trending object failed. - This message indicates that an error has 
occurred during an attempt to call Persistent Trending's Open method. Make sure that Persistent 
Trending application has been properly installed and registered. 
'EnterRuntime' method of Persistent Trending object failed. - This message indicates an error 
has occurred during an attempt  to call EnterRuntime method of Persistent Trending. Make sure 
that Persistent Trending application has been properly installed and registered. 
'ExitRuntime' method of Persistent Trending object failed. - This message indicates that an 
error happens during an attempt to call “ExitRuntime” method of Persistent Trending. Make sure that 
Persistent Trending application is properly installed and registered. 

TrendWorX SQL Data Logger 
Error Opening About Box - It appears when the Data Logger cannot display the About box 
Information. Make sure that the SmarAbout.dll has been properly installed and registered. 
Insufficient Security Level! - It appears when the user attempts to perform an operation within the 
Data Logger without having the required security attributes in the ProcessView Security Server. 
The selected language translation is not available. - It appears when the user tries to switch 
languages and the Data Logger has not found the required language resource DLL. 
OLE initialization failed.  Make sure that the OLE libraries are the correct version. - It appears 
upon startup if the system OLE libraries have not been properly installed or are not up to date. 
Cannot change files while OPC Clients are connected to this server. - It appears when the user 
tries to shutdown the Data Logger and there are DCOM/COM clients connected to it (including 
Trend ActiveX's, TrendWorX Configurator, and VB Scripting clients). You should shutdown all client 
applications first. 
Cannot change files while OPC Clients are connected to this server. - It appears when the user 
tries to open a new *.txd configuration file on the Data Logger and there are DCOM/COM clients 
connected to it (including Trend ActiveX's, TrendWorX Configurator, and VB Scripting clients ). You 
should shutdown all client applications first. 
Not A Valid Configuration Name - It appears when you try to export an existing 5.20 *.txd 
configuration file to the new TrendWorX Configuration database using an invalid configuration name. 
Failed to Connect to Database - It appears when you try to export an existing 5.20 *.txd 
configuration file to the new TrendWorX Configuration database and the Data Logger fails to 
connect to the database.  Make sure that the configuration database exists and is not opened in 
Exclusive mode. 
An error log was generated. Do you want to save it? - It appears when you try to export an 
existing 5.20 *.txd configuration file to the new TrendWorX Configuration database and errors occur 
while exporting the configuration.   
In addition to the above user interface error messages, the Data Logger sends the following 
messages and errors to the Gen Registrar (and, if desired, to the NT Event Logger). 
Started Logging (Severity 500) - When entering Runtime mode. 
Stopped Logging (Severity 500) - When exiting Runtime mode. 
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Failed to create threads - runtime aborted (Severity 800) - The Data Logger could not enter 
Runtime mode.  Make sure that the computer is not running out of memory or resources, or running 
some extremely CPU-intensive application. 
Database Group DeActivated (Severity 600) - A database group has been deactivated, and 
logging for it is not active. 
Activated Database Group (Severity 600) - A database group has been activated, and logging for 
it is now active. 
Logging Group De-Activated (Severity 600) - A logging group has been deactivated, and logging 
for it is not active. 
Activated Logging Group (Severity 600) - A logging group has been activated, and logging for it is 
now active. 
Switched Logging Database Connection (Severity 650) - The database group have switched 
database connections in response to an external command. 
Conflicts In Table Naming - aborted runtime  (Severity 800) - The Datalogger has aborted 
Runtime due to conflicts in table-naming and overall data logging configuration.  On starting 
Runtime mode or uploading a configuration file, the Data Logger tries to perform a database 
consistency and conflict resolution test. You should make sure the table names selected for data 
logging include no improper characters such as ^,*, etc.; that the target historical database has not 
been deleted; has been properly configured; and the security attributes of the database allow the 
Data Logger application to read, create, and alter database tables without any restrictions. 
Errors Found in Activating Database Logging Group (Severity 750) - The Data Logger could not 
activate the desired Database Group.  You should make sure that table names selected for data 
logging do not include improper characters such as ^,*, etc.; that the target historical database has 
not been deleted and has been properly configured; and the security attributes of the database allow 
the Data Logger application to read, create and alter database tables without any restrictions. 
Errors in De-Activating (Severity 750) - The Data Logger could not activate the desired Database 
or Logging Group.  The Database or Logging Group has already been deactivated.   
Database Switching Failed!  (Severity 750) - The Data Logger failed to switch database 
connections for a database group.  Make sure the new database has been properly configured and 
the Data Logger application has the proper security settings to create, open and modify tables.  Also 
make sure that enough ProcessView client units are available to switch to a high-end-supported 
database. 
Missing Logging Tags  (Severity 650) - The Data Logger failed to request a configured tag from 
the corresponding OPC server.  Make sure that the tag has been configured in the OPC server 
database. 
Error in Connecting to Database  (Severity 750) - The Data Logger lost database connection 
while data logging.  Make sure the database is available; the network connection is active; and a 
user or administrator has not opened the database in Exclusive mode. 
Established Connection to Database (Severity 500) - The Data Logger has restored connection 
to the logging database. 
Maximum Number of Packets Reached - Possible Data Loss (Severity 650) - The Data Logger 
has reached the maximum number of data logging packets to hold in memory (on a per-logging-
group basis); as a result, data loss may occur.  Make sure the PC is not overloaded; the database is 
available; the network connection is active; and a user or administrator has not opened the database 
in Exclusive mode. The configuration of data logging may have to be evaluated to prevent the 
system from overloading. You may also have to modify registry settings for the maximum number of 
packets. 
Lost Data Packet (Severity 750) - The Data Logger has had to discard a logging packet because 
either the maximum number of data logging packets to hold in memory has been reached or the 
maximum number of retrials for data logging a packet of data has been exceeded.  Make sure the 
PC is not overloaded; the database is available; the network connection is active; and a user or 
administrator has not opened the database in Exclusive mode. The configuration of data logging 
may have to be evaluated to prevent the system from overloading. You may also have to modify 
registry settings for the maximum number of packets or data-logging retrials. 
Retried To Log Data (Severity 650) - The Data Logger has had to retry to log a logging packet.  
Make sure the PC is not overloaded; the database is available; the network connection is active; and 
a user or administrator has not opened the database in Exclusive mode. The configuration of data 
logging may have to be evaluated to prevent the system from overloading. You may also have to 
modify registry settings for the maximum number of packets and/or data-logging retrials. 
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ScriptWorX and SwxEngine 
Scripting engine did not start yet, do you want to wait? – Script engine has not started in the 
expected time. The computer can be overloaded, so wait for a while. 
Failed to start scripting engine. The application cannot fully operate! – Check that the scripting 
engine SwxEngine.exe is available and has been registered. Try to re-install the application. 
Application failed to register properly at GenRegistrar server and will terminate now. – Check 
that the GenRegistrar component has been installed. Try to re-install the application. 
Error Initializing VBA – Failed to properly initialize VBA component. Try to re-install the application. 
Cannot start Subscription Editor. – Check that the component has been installed. Try to re-install 
the application. 
Scripting engine disconnected. It is recommended to restart the ScriptWorX.  Press OK to 
exit now, press Cancel to continue. – Scripting engine has unexpectedly been terminated. Restart 
the application. 
Configuration of console events failed when calling the scripting engine. – Failed to configure 
the scripting engine. Try to restart the application. Check if there is only one instance of SwxEngine 
in the Task Manager. 
Configuration of system events failed when calling the scripting engine. – Failed to configure 
the scripting engine. Try to restart the application. Check if there is only one instance of SwxEngine 
in the Task Manager. 
Setting of current directory failed when calling the scripting engine. – Failed to configure the 
scripting engine. Try to restart the application. Check if there is only one instance of SwxEngine in 
the Task Manager. 
Another instance of ScriptWorX is already running. – The ScriptWorX configurator and monitor 
(ScriptWorX.exe) can run only in one instance. An attempt to run a second instance has been 
detected.  

Run Script 
No available idle thread to run the script or the script failed. – Either increase the number of 
script engine available threads in ScriptWorX Tools | Set Number of Threads or configure the 
application to run fewer scripts in a given period of time, or optimize the scripts to run faster. Check 
if some scripts do not hang up in the scripting engine (i.e., in never-ending loops, etc.). 
Script <ScriptName> failed to run because of no idle thread was found. – Either increase the 
number of script engine available threads in ScriptWorX Tools | Set Number of Threads or configure 
the application to run fewer scripts in a given period of time or optimize the scripts to run faster. 
Check if some scripts do not hang up in the scripting engine (i.e., in never-ending loops, etc.). 
Scripting engine failed to start a script <ScriptName>. – Check if there is the scripting engine in 
the Task Manager and if the application is in Runtime mode. Check if the DLL containing the script 
has been made from the related *.vba project and has been correctly registered. Check if the 
project, module, and script name match the related VBA project, VBA module, and procedure. Note: 
The script can be started only from the Designer module (named "Main" by default). 
Scripting engine failed to suspend a script <ScriptID>. - The script could already be finished; 
therefore, it has not been possible to suspend it. 
Swx32 SuspendScript: Script is not found in the scripting engine. It could already finish. - 
The script could already be finished; therefore, it has not been possible to suspend it. 
Scripting engine failed to resume a script <ScriptID>. - The script could already be killed; 
therefore, it has not been possible to suspend it. 
Swx32 StartScript(): Call method StartRuntime prior to StartScript. – Application is not in 
Runtime mode. Use StartRuntime method to put it into Runtime. 
Scripting engine failed to terminate a script <ScriptID>. - The script could already be finished; 
therefore, it has not been possible to suspend it. 
Not all scripts exited yet. Press OK to terminate them, press Cancel to wait for a while. -  
Some scripts can take longer to finish. Wait for a while to let them finish. Check to see that they do 
not contain deadlocks or never-ending loops. 
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Synchronization of File and VBA Editor  
The related VbaMT project (*.vba) was not found. Please open the VBA editor and locate the 
project manually using File > Open Project.... – Open the VBA editor and use menu File > Open 
to load the project manually. 
Failed to open VBA project: <ProjectName> Check the project exists and load it manually in VBA 
editor. – Open the VBA editor and use menu File > Open to load the project manually. 
Failed to compile VBA project. Check if the VBA Project name matches the current Project name. 
You can open VBA editor and make the DLL manually using menu item File > Make 
<Project>.DLL... – There has to be a VBA project and module opened in the VBA editor, whose 
names must match the names "Project" and "Module" in a script trigger configuration to compile 
from the configuration screen. Note: It is possible to compile manually a VBA project and module in 
VBA editor, assuming the project and module names have been typed in the related fields in the 
script trigger configuration screen. 
Failed to add a script code. Check if there is the related project matching current file name loaded 
and if it contains designer module Main. – Open the VBA editor and use menu File > Open to load 
the related project manually. 
Failed to jump to a specified script procedure. Check if the procedure exists in specified module. 
– Open the VBA editor and use menu File > Open to load a project containing the procedure 
manually. 
Procedure <ScriptName> not found in current project or the scripting engine not ready. – 
Make sure the scripting engine is ready and the VBA contains the related project and procedure. 
Use menu File > Open to load the project manually. 

Script Wizard 
Script wizard failed to insert a script procedure into current project or the scripting engine 
not ready. Check if the current project exists in the VBA editor. Create it manually if necessary. – 
Open the VBA editor and use menu File > Open to load the project manually. 
Script wizard template files not found in the <DirectoryName> directory. The Script Wizard 
exits now.  - Check if the script wizard directory has been presented in the installation directory and 
if it contains the subdirectories with *.stp (script template) files. Script template *.stp files are regular 
ASCII files. It is possible to check them, for example, in Notepad. 
Script wizard provided no code for the script body. Check the script template files. - There was 
no VBA code found in the script template file. Check the script template *.stp file in the related 
ScriptWizard directory. Script template *.stp is an ASCII file. It is possible to check it, for example, in 
Notepad. 
Script wizard template script does not contain required keyword # : which separates the 
header from the script. - The script template does not contain the expected keyword, which closes 
the Header section. Check if the script template has not been damaged. Script template *.stp is an 
ASCII file. It is possible to check it, for example, in Notepad. 
Failed to compile current project into VbaMT DLL. - The VBA project could not be compiled into 
VBA DLL, and the scripts inside this project will not run. The reason could be either a missing VBA 
project (create/open the correct one in VBA Editor using either menu File > New or File > Open) or 
there is a syntax error in the compiled scripts (open VBA Editor and try the menu Debug > Compile 
<Project>. This usually provides you with a good idea of what the problem is. Then try to compile the 
project manually using the menu File > Make <Project>. 
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Security 
Insufficient security level. Log as a client with the necessary security rights. - The current user 
is not allowed to do the intended action. Log in as a user with the proper security rights. Refer to 
Security documentation. 
Insufficient security level to start application. Log as a client with the necessary security 
rights.  - The current user is not allowed to do the intended action. Log in as a user with the proper 
security rights. Refer to Security documentation. 
Insufficient security level to exit application. Log as a client with the necessary security 
rights.  - The current user is not allowed to do the intended action. Log in as a user with the proper 
security rights. Refer to Security documentation. 
Insufficient security level. Log-in as a user with the proper security rights. - The current user is 
not allowed to do the intended action. Log in as a user with the proper security rights. Refer to 
Security documentation. 
Insufficient security level to configure the scripting engine. Log-in as a user with the proper 
security rights. - The current user is not allowed to do the intended action. Log in as a user with the 
proper security rights. Refer to Security documentation. 
Unable to run the security login client. Make sure the file Login.EXE exists in the same 
directory as this application.  - The Login.exe has failed to start. Check if the security is installed 
on the current computer and if the Login.exe is in the ScriptWorX installation directory. 
Unable to launch the security configuration application. Make sure the file Security.EXE 
exists in the same directory as this application. - The Security.exe has failed to start. Check if 
the security is installed on the current computer and if the Security.exe is in the ScriptWorX 
installation directory. 
Script <ScriptName> failed to run because of security. - The current user is not allowed to do 
the intended action. Log in as a user with the proper security rights. Refer to Security 
documentation. 

AlarmWorX 
AlarmWorX Server 

Internal errors encountered by the AlarmWorX Sever are reported via the Smar Event Server, 
another OPC Alarm & Events compliant server. The Smar Event Server can optionally write selected 
events to the NT Event Log. The following simple events can be generated by the AlarmWorX 
Server 
 

Severity Message 
500 "%1 %2 Started." 

500 "%1 %2 Stopped." 

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Unknown" 

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Tag does not exist." 

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Rejected by Security Server." 

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Licensed I/O Point Count Exceeded. " 

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Demo mode has timed out." 

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Local I/O not allowed on Browser node." 

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: COM error registering with GenRegistrar." 

800 "%1 %2 Failed to Register with GenRegistrar. Reason: %3" 

800 "No configuration found for node and no ""Default"" configuration in Database Provider: %1 Connection:  
%2" 

800 "Database Error - Provider: %1 Connection: %2" 

 
For the Smar Event Server, severity values of 600 and below are considered “normal.” Severity 
values of 601 to 1000 are considered errors. 
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AlarmWorX Logger 
Any error conditions encountered by the logger will be reported via the Smar Event Server and 
optionally to the Windows NT Event Log. 
To allow the logger to send messages to the NT Event Log, select Start > Programs > Smar 
ProcessView > License Monitor. Select the Events tab. Check AWXLog32 in the list of 
applications, as shown in Figure 12.1. 

 
Figure 12.1.  NT Event Log Configuration 

Here are the possible messages: 

Severity Source Message 
500 AWXLog32 SMAR AlarmWorX Logger Started. 

500 AWXLog32 SMAR AlarmWorX Logger Stopped. 

500 AWXLog32 Primary Printer "%1" now in service. Printing on Backup Printer "%2" terminated. 

500 AWXLog32 Printing has resumed. 

500 AWXLog32 Configuration "%1" INSERT INTO table "%2" succeeded. 

750 AWXLog32 Failed to Open Primary Printer "%1" 

750 AWXLog32 Configuration "%1" printer event queue overflow. Messages have been lost. Queue 
size is %2 events. 

750 AWXLog32 Primary Printer "%1" has failed. Now Printing on Backup Printer "%2." 

750 AWXLog32 Configuration "%1" filter is inactive due to syntax error(s). 

750 AWXLog32 Configuration "%1" logging event queue overflow. Messages have been lost. Queue 
size is %2 events. 

800 AWXLog32 

Error opening Configuration Database: 
Provider: %1 
Connection: %2 
(Error string from database is in "Comment" Attribute.) 

800 AWXLog32 

Error Querying Configuration Database: 
Provider: %1 
Connection: %2 
Query: %3 
(COM error string is in "Comment" Attribute.) 

800 AWXLog32 
Configuration Database has no configuration for "Node" and no "Default." 
Provider: %1 
Connection: %2 

800 AWXLog32 Error opening Logging Database for Configuration "%1" 
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Severity Source Message 
Provider: %2 
Connection: %3 
(COM error string is in "Comment" Attribute.) 

800 AWXLog32 
Query of Column definitions failed for configuration "%1" 
Query: %2 
(COM error string is in "Comment" Attribute.) 

800 AWXLog32 

Error opening Configuration Database: 
Provider: %1 
Connection: %2 
(COM error string is in "Comment" Attribute.) 

800 AWXLog32 

Configuration Database has no configuration "%1". 
Provider: %2 
Connection: %3 
(COM error string is in "Comment" Attribute.) 

800 AWXLog32 Configuration "%1" subscription to OPC Event Server(s) failed. 

800 AWXLog32 Configuration "%1" error assigning value to column "%2" 

800 AWXLog32 Configuration "%1" INSERT INTO table "%2" failed 
(Error string from database is in "Comment" Attribute.) 

800 AWXLog32 Failed to register "%1" with GenRegistrar. Configuration "%2" will not execute. 

800 AWXLog32 Printing to both Primary Printer "%1" and Backup Printer "%2" has failed. 

AlarmWorX Report 
Database Type not supported - Error occurs when ConnectionString property is set to the string 
specifying OLE DB connection to a database other than MS ACCESS or MS SQL Server. 
Crystal Reports Database Connection was not configured. Would you like to select ODBC 
connection now? - This message box pops up during an attempt to launch Crystal Reports (either 
by clicking Report button on AWXRep32 toolbar or calling LaunchReport method) when Crystal 
Reports have not previously been configured.  By selecting Yes button, you could open the ODBC 
panel and select the appropriate ODBC connection for Crystal Reports configuration. 
Crystal Report failed during connection to database. - Indicates that incorrect ODBC connection 
was specified for Crystal Reports. Change connection and try again. 
Crystal report - SQL Server Error. - This error indicates that Crystal Reports could not recognize 
the data structure in the given table. It occurs when some columns are renamed or deleted. 
Printer error occurred. - This error message appears if incorrect printer response was received 
during alarm data printing. Fix printer problem and try again. 
Can't load toolbar. - This message box appears when loading toolbar resource fails due to lack of 
GDI resources. Restart container application and/or close other applications that use many GDI 
resources. 
Error at toolbar creation. - This message box indicates that attempt to create toolbar failed due to 
lack of GDI resources. Restart container application and/or close other applications that use many 
GDI resources. 

AlarmWorX Viewer 
The selected language translation is not available.  -   The language translation file is not 
available.  Possible reasons are either an incorrect language name or the file is not in the bin 
directory. 
The selected language resource is too old.  Please obtain an updated version of the file. -  
The language file version is incorrect.  A new language file must be created with the current 
resource files. 
Unable to Open File.  - The system could not open the file.  A corrupted file or an unsupported 
version could be the cause. 
Unknown Version.  Using Default Settings.  - The system did not recognize the alarm viewer 
information stored in the document.  A corrupted file or an unsupported version could be the cause. 
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DataWorX 
Error messages that appear in the message boxes: 
OLE initialization failed.  Make sure that the OLE libraries are the correct version. - DWX 
cannot run because of problems with OLE. The user should check OLE DLLs. 
The selected language translation is not available. - You tried to select another language, but the 
translation DLL cannot be found. Contact your local vendor to get the proper translation DLL. 
The selected language resource is too old. Please obtain an updated version of the file: - You 
attempted to select another language, but the available translation DLL is outdated. 
At least two nodes must be defined. - Two nodes must be defined for redundancy--a primary 
node and at least one backup node. 
Specified common name is not unique. - The name specified as "Common Name For 
Redundancy" must be unique within all DWX registers. Choose another name. 
Specified name of node status register is not unique. - The specified name of the node status 
register must be unique within all DWX registers. 
Automatic runtime start was not allowed by the security server. - DWX is set up to go into 
Runtime when started by an OPC client, but the system security has denied it. See the security 
administrator to allow this action. 
DataWorX cannot reference itself via OPC. - Referencing OPC items itself is not allowed. DWX 
can work only with other OPC servers. Tip: Try to delete the SMAR.DataWorX string to get what you 
want. 
DataWorX can only reference its aliases at this place. - DWX can only reference itself when the 
point name contains aliases. 
Error writing point: <point name> - DWX cannot write into the given point. Check security related 
to that point and the OPC server configuration. The point might be read-only. 
Can't read header data from file <filename> - The specified CSV file does not have a header. 
File <filename> has invalid structure. - The specified CSV file does not have a valid format. 
Check for missing double-quotes, and the proper number of commas in every line, etc. 
Can't convert value(s) from file <filename>. - The given CSV file contains a value that cannot be 
converted to the required data type. 
Can't export CSV file: <filename> - DWX cannot write to specified file. 
Can't import CSV file: <filename> - DWX cannot read specified file. 
Genesis Registration Server denied running DataWorX. - DWX cannot run because there are no 
client units left. Close some other ProcessView application to run DWX. 
Another instance of DataWorX is already running. - Only one instance of DWX can run on a 
computer at a time. Close the other one first. 
Specify name of the OPC item. - Specify the OPC item name in the form: [\\<node name>\]<server 
name>\<item name>. 
Error opening About Box. - DWX cannot find About box. 
Unable to run the security login client. - DWX cannot find the security login application. Make 
sure ProcessView has been properly installed. 
Unable to launch the security configuration application. Make sure the file Security.EXE 
exists in the same directory as this application. - DWX cannot find the security configuration 
application. Make sure ProcessView has been properly installed. 
Error messages that may appear in the output window: 
<item name>: Add item FAILED. - DWX cannot access the specified OPC item because AddItems 
operation has failed. The specified point probably does not exist in the server. Check the point name 
and the OPC server configuration. 
<item name>: Demo over. - DWX cannot access the specified OPC item because the Demo mode 
is over. DWX must be restarted to work in the Demo mode again. 
<item name>: Point count exceeded. - DWX cannot access the specified OPC item because the 
total number of accessed points have exceeded the limit given by the license. Close some other 
ProcessView application. 
<item name>: Error: Local point not allowed. - The current license does not allow accessing 
points locally. 
<item name>: Error: Genesis Registrar not found. - DWX cannot locate the Genesis Registrar to 
get the license information. 
<item name>: Generic ERROR. - A generic OPC error occurred when DWX tried to access the 
specified OPC item. 
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 License Utility 
License utility errors are generated while running the License Utility. These errors appear on a dialog 
box and are of the following format: 

License Utility Error (CKERR - #): 
(error details) 

Refer to License Utility Help for more information. 

Initialization Errors  
Initialization of Key Protection Failed - General failure message,  which is further described by a 
second message. This error can occur if files related to the License utility have been moved or 
deleted. If the operating system is Windows NT, make sure CRYPSERVICE service is running. If the 
problem persists, restart your computer and re-install the Licensing Utility. 
Unable to Find Program File. -  The Licensed Program file could not be found. This problem 
occurs only if the folder or files related to the licensing utility have been tampered with. Uninstall the 
licensing utility and re-install it. 
Incorrect Master Key. -  The License Utility in use does not support this product. This problem 
occurs only if the folder or files related to the licensing utility have been tampered with. Uninstall the 
licensing utility and re-install it. 
Master Key Does Not Match Program. -  The License Utility in use does not support this product. 
This problem occurs only if the folder or files related to the licensing utility have been tampered with. 
Uninstall the licensing utility and re-install it. 
Unable to Create License Files. - Disk error has occurred. This can also be due to insufficient disk 
space. Make sure you have at least 1 MB of free disk space for the licensing utility. 

Authorization Errors  
A valid license already exists.  The License must be Killed before enabling Backup 
Authorization. - The Backup Authorization allows a user to authorize a second temporary license in 
case a failure occurs during a license upgrade.  If the license is already valid, there is no need to 
authorize another temporarily. 
Failed to Authorize Software Key. - A valid license does not exist. Get a valid software license. 
Software Key Is NOT Initialized. - A reference to the Site Key was not possible because prior 
initialization failed. Restart the Licensing Utility and try again. 
Attempt to Run from Floppy. - A PC is licensed using one of the hard drives.  The license cannot 
be issued to or exist on a floppy diskette. 
Software Key has been moved  (or) password is incorrect. - The Site Key issued was created 
with an invalid password.  This error can also occur if the Site Key entered belonged to a prior Site 
Code that has subsequently changed.  For example, a Site Code was generated and returned to 
Smar.  Meanwhile, a temporary Site Code had been installed before the original site key was 
installed.   
Master Key Does Not Match Program. - The license may have been renamed. 
The System Time has been set to a Date previous to Site Key. - Tampering with the date or time 
can invalidate a time-limited license. 
The Restriction File has been Deleted. - One of the license system files has been deleted. You 
may have to obtain a new license. Contact Smar. 
Restriction File has been Damaged. - One of the license system files has been tampered with. 
You may have to obtain a new license. Contact Smar. 
Restriction File has been Moved or Overwritten. - One of the license system files has been 
moved. You may have to obtain a new license. Contact Smar.  This may be caused by reformatting 
drive C: on a single drive containing two partitions. 
User has Attempted to use an old Site Key. - Site Keys cannot be reused. You may have to 
obtain a new license. Contact Smar. 
Failed to Save Site Key!!! - An error occurred while entering a new Site Key.  You may have to 
obtain a new license. Contact Smar. 
User Is trying to Reuse Old Key - Site Keys cannot be reused. 
Key Has Been Mis-typed. - The entered Site Key is not valid. 
The License File Could NOT be Written.  Disk Full ??? – Check to see if disk is full. 
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Failed to get site code. Reinstall the license utility 
The entry file was unable to be opened. - One of the license system files may have been moved. 
Move the files back to their original folders. 
Unable to Get Key Restrictions. - The license could not be read properly. This error may occur 
due to improper initialization. Exit the licensing utility and try again. 

Transfer Errors  
Only Unauthorized Sites can be Used! - A license cannot be transferred to an existing authorized 
PC. 
Problem in Opening Registration File in specified directory. - The diskette file containing 
transfer information could not be opened from the supplied directory due to invalid directory, write 
protection, disk not ready or no disk space.  Check diskette and try again. 
Target diskette already has authorization files.  Proceed to step 3. - The transfer diskette 
already contains registered files. Proceed to step 3. 
Site Can have Only One outstanding registration at a time! - Once a floppy has been registered, 
the license utility does not allow a second floppy to be initialized. To override this limitation, delete 
the  PROCVIEW LICENSE.REG file from the \ProgramFiles\Smar\Softlic directory and try again. 
Could not Open matching Registration File. - The matching registration file in the same directory 
as the program could not be opened.  Check transfer diskette and try again. 
Could not Write Matching Registration File. - The matching registration file in the same directory 
as the program could not be written to.  Check transfer diskette and try again. 
License Transfer In error. - General message, which is further detailed by a second message. 
Transfer Is Allowed only for Unauthorized Software Key. - A license cannot be transferred to an 
existing authorized PC. 
Could Not Find Registration File for Software Key. - Make sure the transfer diskette has been 
installed at specified path and try again. 
Outdated Registration Files are used. - The transfer diskette in use does not apply to current 
transfer. 
Unable to find Site Key in Given directory. - A valid Site Key was not found on transfer diskette.  
You may have to obtain a new license. 
The Site Key File has been damaged. - A valid Site Key was not found on the transfer diskette. 
You may have to obtain a new license. 
Unable to Find Registration file on Floppy. - The transfer diskette was not registered properly in 
Step 1 of the transfer. 
Transfer is attempted for different application. - The license being transferred from this PC is not 
of the same license type on destination PC. 
Transfer Files are Already in Floppy. - The transfer diskette already contains the license to be 
transferred. 

License Removal Errors 
Invalid Password - A password is needed to delete a Site Key.  Call Smar. 
Cannot create KILL.TXT File. - Details of license removal could not be written to disk. 
Failed to Destroy the License. 
Software Key Is NOT Initialized. - Exit the license utility and try again. 
The protected program is not authorized. - Exit the license utility and try again. 
The license files are currently write protected. - Exit the license utility and try again. 

Temporary Licensing Errors  
Temporary Authorization Period has expired. - The license utility attempted to create a 30-day 
license, but the one-time-only license had already been used and has since expired. You cannot use 
the 30-day temporary authorization more than once. 
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General Errors 
Could Not Get License Information. - Exit the license utility and try again. 
Failed to Initialize Software Key. - If running NT, make sure CrypKey.INI file has accurate paths 
and reboot. Exit the license utility and try again. 
Unable to Perform the Thunk Operation. - Exit the license utility and try again. 
Registry Query Error. - Exit the license utility and try again. 
Unable to close file. - Check hard drive. Exit the license utility and try again. 
Disk access error - Check hard drive. Exit the license utility and try again. 
File could not be written. - Check hard drive. Exit the license utility and try again. 
File data item could not be written. - Check hard drive. Exit the license utility and try again. 
GlobalLock/GlobalUnlock failed - An error occurred while accessing ClipBoard.  Another 
application is currently using ClipBoard. Exit the license utility and try again. 
Error creating Registration Text File. - Exit the license utility and try again. 

Security 
Security Server 

NT Application Event Log Messages 
The following messages will appear in the Windows NT Event Log under normal operation. These 
messages are for the administration and are not error messages. 
User %1 has logged in from station %2. This message appears when a user logs in from a node. 
User %1 has logged out from station %2. This message appears when a user logs out from a 
node. 
User %1 has been automatically logged out from station %2. This message appears when a 
user is automatically logged out from the system. 
Smar Security Server has started. This message appears when the Smar Security Server starts. 
Smar Security Server has shutdown. This message appears when the Smar Security Server 
shuts down. 
User %1 has logged in for Administration. This message appears when a user logs in as the 
administrator. 
User has logged out for Administration. This message appears when a user logs out as the 
administrator. 
Software License not found.  Beginning %2 hour demo. This message appears when a user 
starts PROCESSVIEW and a valid license is not found. The system starts in the Demo mode. 
Software License not found and demo period expired. ALL ACCESS DENIED. This message 
appears when PROCESSVIEW runs in the Demo mode and shuts down after the Demo period. 

Message Box Errors 
Error loading AppSec.DLL! - The dll APPSEC.DLL must be in the same directory as the security 
server (SECURITY.EXE). This file could not be found or is corrupt. You must copy this file back or 
reinstall ProcessView after uninstalling the current setup. 

Login Client 
The Security Server is not installed on the local computer. - Install the Security Server, or select 
Preferences from the Options menu and choose the network node where the Security Server has 
been installed. 
The Security Server is not installed or is not responding on network node %1. - This is usually 
caused by a network failure. To select a Security Server installed on a different machine, select 
Preferences from the Options menu and choose a working network node where the Security 
Server has been installed. 
Smar About Box Automation Server is not registered! - The installation of ProcessView failed to 
register the About Box Automation Server. Reinstall ProcessView. 
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 Tag Browser 
The Tag Browser has two types of error messages:   
• Debug error messages 
• Normal operation error messages 

Debug Error Messages 
Debug error messages are created when the user goes to the menu item View and enables 
(checks) the Debug selection.  This enables any COM/DCOM error messages to be posted to the 
user.  These error messages are used for debugging COM/DCOM communication between the Tag 
Browser and an OPC server.  The Tag Browser reports these messages.  Most likely, an 
unsupported optional interface causes a message in this area.  OPC errors reported by the Debug 
option are detailed in the OPC Data Specifications and COM errors are detailed in COM/DCOM 
manuals or Microsoft Developers Network documentation. These errors are used primarily for OPC 
server development. 

Normal Operation Error Messages  
Should a problem occur during the normal operation of the Tag 
Browser, a message box will be created to report the instance. Some COM errors are produced 
during normal operation, and do not indicate any problem.   
Tag Browser messages are as follows: 
Errors due to insufficient system resources: The following four errors occur when your computer 
system runs out of resources such as memory. If this happens during configuration, you must save 
the current work, close all applications, and restart them. 
Failed to Delete String from Combo Box  – A string has been deleted from the combo box. 
Error Adding Item to Combo Box - The string item has not been added to the combo box. 
Not Enough Memory to Add Item to Combo Box – The system did not have enough memory to 
add an item to the combo box.  This is indicative of the system's running out of memory. 
Failed to Set Item Data in Combo Box – The item data was not set in the combo box. 
The following four errors occur if the OPC servers do not support the interface via COM/DCOM. Try 
the same steps again. If the problem persists, close all applications, restart them, and retry again. 
• The OPC Server Failed to Return Branch Information - The OPC server failed to return 

branch information. 

• The OPC Server Failed to Return Leaf Information - The OPC server failed to return leaf 
information. 

• The OPC Server Failed to Return Flat Information - The OPC server failed to return 
information for a flat hierarchy 

• The OPC Server Failed to Return Interface Type – The OPC server failed to return the OPC 
interface type  (flat or hierarchical). 

Invalid Window Handle. – Tag Browser was launched from an application that passed an invalid 
window handle. Typically, it is a third-party application. Call SMAR if the problem persists. 
Network Error- Tag Browser could not resolve the requested network level.  Please verify that the 
current security settings allow this network action. It is a good idea to browse the computer you are 
trying to reach using Windows Explorer > Network Neighborhood to make sure that the computer 
is online. 
If Debug messages are enabled, it is possible to receive a Debug error message and a Normal 
Operation error message at the same time. This is due to the fact that the Debug messages and 
Normal Operation messages overlap in areas of the OPC optional browse interface required for 
successful operation of the Tag Browser.  
Note: Not all OPC servers support the IOPCBrowseAddressSpace optional interface.  Please verify 
with your OPC server vendor whether their OPC server supports this interface. 


